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Introduction 
Congratulations on your choice of a state-of-the-art WizCom SuperPen. Inside its tip, your Pen 
contains a sophisticated electronic eye mounted above two rollers. This eye enables you to 
scan different types of printed information, such as notes, addresses, business cards, Internet 
links, and tables, directly into your Pen.  
 
Use the Pen to scan printed text and view definitions and translations of the scanned words - 
from the dictionaries installed on your Pen.  
 
Use the Pen to scan real-time into applications on your computer, or store the data and 
transfer it at your convenience to the Desktop application, other applications on your 
computer, or IrDA OBEX-compliant PDAs, and cell phones. 
 

Contact and Support Information 
If you have any questions about this product or how to use it, please feel free to contact us: 
o Send E-mail: usa.support@wizcomtech.com. 
o Check our website at: http://www.wizcomtech.com. 
Most technical problems are related to conflicts in particular hardware configurations and are 
not operational defects in the Pen or in the Desktop application. WizCom's technical support 
team is usually able to sort through these communications conflicts within minutes. 
 

Terminology 
Pen: 

The scanning device. 
Scan: 

To roll the Pen over printed text. Please refer to the Getting Started (on the back of the 
SuperPen package) for more information. 

Highlighted: 
When text, numbers or graphics appear inversed on the Pen screen. For example, when 
text is highlighted, it appears green with a black background (instead of black text on the 
green background). 

Select: 
To ‘select’ an option means that you should scroll to the option – until it appears on the 
screen, or until it is highlighted, and then press the Pen  button in order to activate the 
option or enter a sub menu or screen. 

Dictionary: 
In this manual, this is short for the dictionary installed on the Pen and used in the 
Quicktionary application. Note: Throughout this manual, the screen shots are of a Pen 
installed with the AHD Concise English to English dictionary. 

Desktop: 
The QuickLink Desktop application is the PC element of this product, enabling Pen-PC 
Communications. 

Pen-PC Communications: 
Functions that involve communications between the Pen and the computer and are done 
when the Pen and PC are connected (cable or Infra-Red). 

PC-Link Connector: 
The outlet at the back of the Pen into which the cable plug is connected. 

USB Cable: 
The cable provided in your package for connecting the Pen to the PC. This cable 
connects to the USB outlet of your computer and to the PC-Link Connector on the Pen. 
The Pen and PC communicate with what is called ‘serial’ communications. 

IR: 
Abbreviation of ‘Infra-Red’, which is an additional type of communications available for 
Pen-PC communications. 
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Conventions 
o The procedures in this manual are accompanied with graphic icons of the buttons you 

need to press, for example, ‘Press ’ means you should press the bottom left 
button of the Pen. 

o The names of the applications, menus and menu options are displayed in bold type, 
for example, ‘Select the Notes option. The Notes application starts and its main menu 
appears.’. 

o Throughout this manual, the screen shots of the dictionary in the Quicktionary 
application are of a Pen installed with the AHD Concise English to English dictionary. 

 

Copyrights 
ScanSoft and the ScanSoft logo are trademarks or registered trademarks of ScanSoft, Inc. in the US and/or in other 
countries. ScanSoft Text-to-Speech software © 2003 ScanSoft, Inc. All rights reserved. 
 
© 2004 WizCom™ Technologies Ltd. All rights reserved. Ligature ® OCR-on-a-Chip ® licensed from Ligature Ltd., 
copyright © 1995-2004, all rights reserved worldwide. Ligature Compression Technology licensed from Ligature Ltd., 
copyright © 1996-2004, all rights reserved worldwide. Ligature reverse inflection and derivation technology licensed 
from Ligature Ltd., copyright © 1997-2004. All rights reserved. QuickLink-Pen™, Quicktionary ™, Reading Pen™, 
SuperPen™, WizCom and pen design are trademarks or registered trademarks of WizCom Technologies Ltd. All 
rights reserved. 
 
All other brands and product names appearing here are registered trademarks or trademarks of their respective 
holders. 
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Getting Started 
 

Package Contents 
Before using your Pen, please take time to check the package contents to make sure that you 
have received all the following items. If anything is missing, please contact your SuperPen 
dealer. The package contents are: 
o Scanning Device (Pen) 
o USB Cable 
o CD-ROM - includes installations for add-ons, the QuickLink Desktop application, USB 

Driver and free CharacterEyes software (limited version) 
o Earphones with volume control (note: please make sure the volume of the earphones is 

set to low before using them!) 
o Pen case with Opticard sticker 
o Two AAA batteries 
o Documentation: Getting Started (on the back of the SuperPen package), Easy Steps 

(folded inside the SuperPen package) 
 

Set Up Product on PC 
Before starting to use the product you must first set up the product on your PC to allow Pen-
PC Communications (i.e., the data and image transfer between the Pen and your computer). 
This set up procedure will install the USB driver, install the QuickLink Desktop application 
and establish the Pen-PC communications. 
Note: if you wish to use an Infra-Red device, please contact our support team (see Contact 
and Support Information on page 7). 
1. Insert the SuperPen CD-ROM into the CD-ROM drive of your computer. 
2. The Main Menu appears. 

Note: If the Main Menu does not appear automatically, please do the following:  
a. Click the Windows Start button and select Run. 
b. Type x: \setup.exe (where ‘x’ is your CD-ROM drive letter), then click OK. 

3. Click on the Set Up Product on PC button and follow the online instructions of the 3 
stage setup procedure provided. 

Note: You will only have to do this setup once. 
 

What Is already On the Pen 
The scanning device is preinstalled and ready to go – no need for any special setup 
procedures!  
 
Important: 
Please refer to the Getting Started (on the back of the SuperPen package) to see how to 
unpack the Pen and how to scan. 
 
The Pen already contains the following: 
o Quicktionary application – used for scanning printed text and defining and translate the 

scanned words with the dictionaries on your Pen. 
o Notes application – used for scanning excerpts of printed text and storing it on the Pen. 

You can transfer the stored note files to your PC, using the QuickLink function. You can 
also beam notes directly to and from a PDA or smart phone. 

o Address Book application – used for scanning printed contact information (for example, 
from a business card) and storing it on the Pen. You can synchronize the addresses on 
your Pen with addresses on your PC, using the QuickLink function. You can also beam 
addresses directly to and from a PDA or smart phone. 

o Internet Links application – used for scanning printed internet addresses (URLs), and 
storing them on the Pen. You can synchronize the links on your Pen with links on your PC, 
using the QuickLink function. 

o Tables application – used for scanning printed table data storing it on the Pen. You can 
transfer the stored table files to your PC, using the QuickLink function. 
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o Scan to PC function– used for scanning printed text and sending it directly to applications 
on your computer. This function requires having already set up the product on your PC 
(see Set Up Product on PC on page 9). 

o QuickLink function - used for transferring and synchronizing the data you have stored on 
the Pen, using any of the storing applications (known as the QuickLink applications, 
Notes, Address Book, Internet Links and Tables) to the Desktop application and any host 
applications you have set. This function requires having already set up the product on your 
PC (see Set Up Product on PC on page 9). 

o The English Interface Language – all menu options and messages on the Pen appear in 
English. 

 

Adding On to the Product 
You can add any of the following to the SuperPen product: 
o Add-On Applications: you can add the Image Capture application to the SuperPen 

product. This application allows scanning small images, storing them on the Pen and 
transferring them to the PC - using the QuickLink function already on your Pen. The 
applications are added to the Pen Main Menu and into the Desktop application. 

o Spellers: The list of scanning languages on the Pen (see the Scanning Language option 
in the Preferences menu) contains all the languages you can scan – from within the text 
scanning applications (except for the Quicktionary application – in which the language of 
the text to scan is determined according to the source language of the current dictionary 
and the recognition is based upon the available words in the dictionary). The Pen 
recognizes the character sets of these languages. You can add a speller for a specific 
language – to enhance the recognition of the actual words in that language. If you plan to 
scan printed text in a language other than English (which is already installed on your Pen) 
– it is advised to add a speller of that language to the Pen. After adding a speller - select 
the scanning language you wish to use from the menu on the Pen. The speller is 
automatically used by the Pen, in the process of recognizing the scanned text. The current 
Scanning Language – and its speller (when available) are utilized for the scanned texts. 

o Interface languages: interface languages allow viewing the pen menu options and 
messages in other languages in addition to English (which is already installed on your 
Pen). The interface language is added to the Pen and can be set using the Interface 
Language option in the Preferences menu. 

To add on to the product: 
1. Insert the SuperPen CD-ROM into the CD-ROM drive of your computer. 
2. The Main Menu appears. 

Note: If the Main Menu does not appear automatically, please do the following:  
a. Click the Windows Start button and select Run. 
b. Type x: \setup.exe (where ‘x’ is your CD-ROM drive letter), then click OK. 

3. Click on the Install Add-Ons button. 
4. The Install Add-Ons menu appears, offering the available add-ons. 
5. Click on the add-on of your choice and follow the online instructions provided. 

 

Familiarizing Yourself with the Pen 
The scanning device (‘Pen’) contains the following parts: 
In the front you can see: 
o Pen Tip with optical scanning head 
o Protective cover 
o Power button 
o Keypad 
o Display 
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In the back you can see: 
o Battery compartment cover 
o Battery compartment 
o Flash memory card socket 

 
In the rear you can see: 
o PC link connector – the outlet for connecting the plug of the USB cable used for Pen-PC 

Communications. 
o Infra-Red Screen – used when beaming. This screen is also used when an Infra-Red 

device (and not the USB cable) are used for Pen-PC Communications. 
o Earphone Outlet – used for connecting the earphones supplied in the package. 

 
 

The Pen Buttons (keypad) 
The keypad contains seven buttons for operating your Pen: 
o The Power button  is used to turn the Pen on and off.  
o The Enter button  is used in a way similar to the Enter key on a computer keyboard, 

see more information ahead. 
o The Escape button  is used in a way similar to the Esc key on a computer keyboard, 

see more information ahead.  
o The Arrow buttons , ,  and  are used in a way similar to the arrow keys on a 

computer keyboard, see more information ahead. 
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Pressing Them 
Press the Pen buttons as explained in the various procedures of this manual. The procedures 
in this manual are accompanied with graphic icons of the buttons you need to press (for 
example, ‘Press ’) and instructions on how to press them. 
There are a few ways in which to press the buttons. 
Note: not all types of presses are functional in all procedures. In the procedures of this manual 
you will be instructed as to the functions each press will perform. 
 
Here are the types of presses, which are used: 
Regular Press 

A single short press of the button. In this manual, when you are instructed to ‘Press’ a 
button – it means you should perform this Regular Press.  

Double-Click 
To double-click a button, press the button twice in rapid succession. 

Long-Press 
To long-press a button, press the button and hold it down briefly. 

 
Their Functionality 
The specific functions of the Pen buttons are described in each of the procedures or 
instructions in this manual. Here are some of their general behaviors: 
General Behavior: 
o The  button will enter a sub menu or screen, confirm a selection or perform an 

operation. 
o The  button will navigate backwards, close a screen, or cancel an operation. 
o Long-pressing the  button will return to the Pen Main Menu. 
Selecting 
To select an item: 
1. Scroll through the menu or list using  and , until the item you want is highlighted or 

until it alone appears on the screen. 
2. Press .  
Navigating 
o To navigate forward – i.e., open a menu, sub menu or application, select the desired 

option and Press .  
o To navigate backwards, return to a previous menu level or screen from a sub-menu or 

different screen, press . 
Closing Messages or Dialogs 
Some messages (for example, error messages) or dialogs (for example, addresses) display 
“buttons” on the screen. They appear as a command (for example, YES, NO, CANCEL) with a 
circle around it (for example, ). 
Press  to activate a highlighted button (highlighted means in inversed text, for example, as 
in the button ). If the button is not highlighted, use , ,  and  to scroll to the 
desired button, thus highlighting it, and then press . 
 

Scanning 
Scanning means to roll the Pen over printed text (or over an image – done in the Image 
Capture application only). 
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How to Scan 
Please refer to the Getting Started (on the back of the SuperPen package) for instructions on 
unpacking the Pen and scanning. Please note the following additional information: 
o Pen Settings: The Pen arrives with original default settings. There are general Pen 

settings (see The Preferences Menu on page 66) and there are application specific 
settings, in each of the Pen applications. 

o If you are Left Handed: The Pen default is set to right handed scanning. To change it to 
left handed scanning, see Right/Left Handed on page 69. 

o Scanning Direction: The scanning direction is not important, i.e., you can scan from left 
to right (as described in the Getting Started on the back of the SuperPen package) and 
you can also scan from right to left – if you find it easier. 

Scanning Result 
When scanning, the optical head of the Pen scans the surface and creates an image of the 
scanned area which is transferred into the current Pen application. Each Pen application may 
process this image in a different way and according to various settings of the Pen. 
Scanning Limitations 
The Pen allows you to scan images (for the Image Capture application) up to 8mm high or 
printed text (for all other applications, such as the Notes) 6-22 points in size (up to 8mm) in a 
wide variety of fonts and in all colors on contrasting backgrounds except: 
o Red on white 
o White on red 
o Blue on black 
o Black on blue 
Poor Character Recognition 
After scanning, the Pen performs Optical Character Recognition (OCR) of the scanned image 
– resulting with actual text – which should be identical to the text you scanned. Sometimes the 
Pen may have difficulty recognizing the scanned words.  
Please check the Scanning Limitations on page 13 to understand what you can scan. 
Following are other reasons for poor character recognition: 
�� When the page you are scanning is dark, dirty or crumpled. 
�� When the printout is of low quality (for example, when the page has been photocopied). 
�� When scanning printed text that is in a different language then the current scanning 

language. Make sure the scanning language is set to the language you are scanning: 
check the general scanning language which is set in the Preferences menu in the Pen 
Main Menu and check the scanning language set in the specific application you are 
scanning with, which is set in the Edit Menu of the application. You may also be able to 
add a speller for that language, to enhance the recognition. See Adding Spellers on page 
71 for information on adding spellers. 

�� When the setting of the Scanning Options (numeric and Inverse) do not match the 
currently printed text. 

�� When scanning incorrectly (for example, holding the Pen in the wrong scanning angle). 
Try scanning again. Please refer to the Getting Started (on the back of the SuperPen 
package), for more information on scanning properly. 

�� When scanning too fast (this specific situation will cause an error message ‘Scanned too 
fast’). Please rescan text slowly. 

Important: 
If you do not succeed to improve the OCR results, you can use the Character Bar (see The 
Character Bar on page 73) or Opticard (see The Opticard on page 75) to manually edit the 
text on the Pen. 
Poor Image Capturing 
The Image Capture application is used to scan and store small images. 
After scanning, the Pen may have difficulty producing a satisfactory image of what you 
scanned. 
Please check the Scanning Limitations on page 13 to understand what you can scan. 
Following are other reasons for poor images: 
�� When the page you are scanning is dark, dirty, crumpled or of low photocopy quality. 
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�� When scanning incorrectly (for example, holding the Pen in the wrong scanning angle). 
Try scanning again. Please refer to the Getting Started (on the back of SuperPen 
package), for more information on scanning properly. 

�� When scanning too fast (this specific situation will cause an error message ‘Scanned too 
fast’). Please rescan image slowly. 

 
 

Tutorials 
Following are tutorials to help you learn the basics of the SuperPen product: 

Tutorial 1 – Quicktionary 
Tutorial 2 – Notes 
Tutorial 3 – The QuickLink function 
Tutorial 4 – Scan to PC 

Important: 
Before performing tutorials 2, 3 and 4, you must have already run the one time procedure Set 
Up Product on PC from the SuperPen CD-ROM. If you have not yet done this, please refer to 
Set Up Product on PC on page 9, and follow the instructions. 
Notes: 
o The instructions are for a Pen set with the original default settings. 
o The Pen default is set to right handed scanning. To change it to left handed scanning, see 

Right/Left Handed on page 69. 
o For basic instructions on unpacking the Pen and scanning, please refer to the Getting 

Started (on the back of the SuperPen package). 
 

Tutorial 1 - Quicktionary 
This tutorial will take you through the basic usage of the Quicktionary application on the Pen, 
used to scan text and define the words using the current dictionary on the Pen. 
Important: For demonstration purposes, the Pen described here has been installed with the 
English to English AHD Concise dictionary - but the behavior will be similar with any 
dictionary. 
 
Initial Step: Load a Dictionary to the Pen 
The Quicktionary application uses a dictionary. The original Pen does not contain a dictionary. 
If you have not yet loaded a dictionary to your Pen, please follow these instructions. If your 
Pen already has a dictionary on it – you may skip to Step 1 ahead. 
 
To add a dictionary to the Pen: 

1. Insert the SuperPen CD-ROM into the CD-ROM drive of your computer. 
2. The Main Menu appears. 

Note: If the Main Menu does not appear automatically, please do the following:  
a. Click the Windows Start button and select Run. 
b. Type x: \setup.exe (where ‘x’ is your CD-ROM drive letter), then click OK. 

3. Click on the Install Add-Ons button. 
4. The Install Add-Ons menu appears, offering the available add-ons. 
5. Click on the Dictionaries button. 
6. The Dictionaries menu appears, offering the available dictionaries to add to your Pen. 
7. Click on the dictionary* you wish to use, and follow the online instructions provided.  

*Notes: 
o The following tutorial demonstrates a Pen with the “AHD Concise” dictionary loaded 

on it, though you can chose any of the listed dictionaries. 
o If you add more than one dictionary, use the Select Dictionary option in the 

Dictionary menu of the Quicktionary application on the Pen, to set the current 
dictionary – the one you wish to use. 

Step 1: Turn the Pen on 
Task: 
o Remove the protective cover from the Pen & press  to turn the Pen on. If the Pen 

Main Menu is not displayed, long-press  until it is. 
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The Pen display will show: 

 
The Pen Main Menu 

Step 2: Start the Quicktionary application 
Task: 
o Press  to activate the current option and enter the Quicktionary application. 
The Pen display will show: 

 
Input Screen 

o If no dictionaries have been added to your Pen, the Pen will display the message  �No 
dictionaries on Pen�. Please refer to the Initial Step of this tutorial for instructions on 
adding a dictionary to the Pen and then return to Step 1 of this tutorial. 

o The first line of the Input Screen will display the “Scan in…” – specifying the language 
name of the source language of the current dictionary, denoting the language in which the 
printed text you scan should be. Since this tutorial demonstrates the English to English 
AHD Concise dictionary – the first line displays “Scan in English”. 

o The Quicktionary application will utilize the “current” dictionary. If you have one dictionary 
on the Pen – it is the “current” dictionary, but if you have more than one dictionary on the 
Pen, and you wish to switch the current dictionary, use the Select Dictionary option in the 
Dictionary menu of the Quicktionary application on the Pen, to set the current dictionary – 
the one you wish to use. 

Step 3: Scan a line of text 
Task: 
o Scan the following sentence (see how to scan, in the Getting Started on the back of the 

SuperPen package): 
 

This is a test scan text 
 
The Pen display will show: 

 
Word Selection Screen* 

 
The Word Selection Screen appears whenever you scan in more than one word at a time. It 
is split into two sections. The upper section displays the scanned text. The lower section 
displays the dictionary entry corresponding to the highlighted word in the scanned text. 
 
Tip: If the scanned line in the top area of the screen contains errors, or whenever you want to 
scan and define a different line of text - simply scan again. The current text is overwritten with 
the new scanned text. 
 
*For demonstration purposes, the current dictionary is the English to English AHD Concise dictionary - but the 
behavior will be similar with any dictionary. 
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Step 4: Word Selection Screen: Hearing the scanned line read aloud 
Tasks: 
o Press  to highlight the speaker icon. The whole sentence will be spoken out, 

highlighting each word as it is spoken. 
o Press  to read the sentence again. 
The Pen display will show: 

 
Word Selection Screen 

Step 5: Word Selection Screen: Defining Words 
Task: 
o Press  to move along the sentence word by word. Each word is highlighted and 

spoken out, and its definition is shown in the bottom part of the screen. 
o Highlight the word ‘test’. 
o Press  and  to scroll through the currently displayed definition. 
The Pen display will show: 

 
Word Selection Screen 

Step 6: From the Word Selection Screen to the Dictionary Screen 
Task: 
o Press  to view the dictionary entry of the highlighted word (‘test’) in the full Dictionary 

Screen. 
The Pen display will show: 

 
Dictionary Screen 

 
The Dictionary Screen displays the dictionary entry and definitions for a single headword (or 
multi-word heading). The dictionary entry can be accessed by scanning in a single word, or by 
pressing , while using the Word Selection Screen. 
Step 7: The Dictionary Screen: Defining Words 
Task: 
o Press  and  to scroll through the definitions. 
 
Note: When a Word List sign ( ) appears at the top right corner of the Dictionary Screen – 
it denotes the existence of a Word List, containing any identical or related entries, from the 
current dictionary. Press  to view the Word List. Highlighting an entry in the list and 

pressing  will display the definition of the selected word - in the Dictionary Screen. 
 

Tutorial 2 – Notes 
This tutorial will take you through the basic usage of the Notes application on the Pen, used to 
scan text and store it on the Pen. 
 
Step 1: Turn the Pen on 
Task: 
o Remove the protective cover from the Pen & press  to turn the Pen on. If the Pen 

Main Menu is not displayed, long-press  until it is. 
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The Pen display will show: 

 
The Pen Main Menu 

Step 2: Start the Notes application 
Task: 
o Press  as many times as necessary until the option Notes appears on the screen. 
The Pen display will show: 

 
The Pen Main Menu 

Task: 
o Press  to activate the Notes application. 
The Pen display will show: 

 
The main menu of the Notes application 

 
Note: if you already used this application, the screen will show the name of the last file you 
edited in the caption (instead of the ‘No open file’ message) 
Step 3: Create a new file and open it 
Tasks: 
o Press  to activate the highlighted option (New File). 

o Press  to scroll to the OK button and highlight it. 

o Press  to activate the highlighted button (OK). 
The Pen display will show: 

 
A file, open and ready for editing, 

in the Notes screen 
 

A new file named note001* is created, opened and ready for editing. 
 

*Note: if you already used this application the file name will contain a different suffix (e.g., 
note004). 
Step 4: Scan a sentence into the open file 
Following is a sentence spread over 2 lines: 
 

Roll the scanning device over printed words 
and see how the words appear on your Pen. 

 
To scan this whole sentence you will need to scan the first line and then scan the second line. 
 
Task: 
o Please scan the first line. 
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The Pen display will show: 

 
The first line you scanned appears highlighted 

 
Note: If the scanned line was not recognized correctly, press  to delete the highlighted 
text – and scan again. 
Task: 
o Now, continue and scan the second line. 
The Pen display will show: 

 
The whole sentence appears, the second line you just scanned is highlighted 

 
Note: If the scanned line was not recognized correctly, press  to delete the highlighted 
text – and scan again. 
Step 5: Return to the Pen Main Menu 
Task: 
o Press  3 times to close the Notes application and return to the Pen Main Menu. 
 

Tutorial 3 – QuickLink 
This tutorial will take you through the basic usage of the QuickLink function which transfers 
stored files from the Pen to the PC. 
Important: 
Before performing this tutorial, you must have already run the one time procedure Set Up 
Product on PC from the SuperPen CD-ROM. If you have not yet done this, please refer to Set 
Up Product on PC on page 9, and follow the instructions. 
 
Step 1: Prepare the PC 
Task: 
1. Turn your PC on. 
2. Close any applications that are running on your computer. The icons of applications that 

are running appear in the System Tray. It is especially important to close applications that 
use the serial or USB ports of your computer, such as PDAs or digital camera 
applications. 

3. Activate the QuickLink Desktop application that you have already installed during the 
CD-ROM procedure Set Up Product on PC: 

o If, during installation, you chose to add the Desktop to your computer’s startup, 
the Desktop will automatically start running when you start your computer. To 
maximize the Desktop window, click the Desktop icon in the system tray at the 
bottom right side of the screen. If the Desktop window does not appear, select 
the Show Window option from the pop-up menu. 

o If the Desktop application does not run when you start up your computer, or if you 
closed the application, you can start it by clicking the Windows Start menu and 
selecting Programs\QuickLink Desktop\QuickLink Desktop. 

4. Connect the cable to your Pen and PC (the same way you did during the CD-ROM 
procedure Set Up Product on PC). 

Step 2: Prepare the Pen 
Task: 
o Press  to turn the Pen on. If the Pen Main Menu is not displayed, long-press  

until it is. 
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The Pen display will show: 

 
The Pen Main Menu 

Task: 
o Press  as many times as necessary until the option QuickLink appears on the 

screen. 
The Pen display will show: 

 
The Pen Main Menu 

Step 3: Sending the stored Note file from the Pen to the Desktop Application 
Task: 
o Press  to activate the QuickLink function. 
The Pen display will show: 

 
 
The Desktop will show: 
o If this is the first time you have ever performed a QuickLink, you will see the following 2 

dialogs on the PC: 

 
Task: 
o Press Next. 
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Task: 
o Press Finish. 

o If this is not the first time you have performed a QuickLink or if you have just closed the 
above 2 dialogs, you will see the following dialogs on the PC: 

 
During the QuickLink 

 
When the QuickLink is completed 

Task: 
o Press OK. 
Step 4: View the File in the Desktop Application 
Task: 
o In the left pane of the Desktop application window, click on the icon of the application 

whose files you wish to view. To view the text file you created in Tutorial 1 - click on the 
Notes icon: 

 
The Notes icon in the Desktop left pane 
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Notes in the Desktop application 

 
The Desktop will open the selected application and display its list of files - in the middle pane* 
and its current file in the right pane. 
*Note: some applications do not have a middle pane. 
 

Tutorial 4 – Scan to PC 
This tutorial will take you through the basic usage of the Scan to PC function which allows to 
scan text and send it directly into PC applications. 
Important: 
Before performing this tutorial, you must have already run the one time procedure Set Up 
Product on PC from the SuperPen CD-ROM. If you have not yet done this, please refer to Set 
Up Product on PC on page 9, and follow the instructions. 
 
Step 1: Prepare the PC 
Tasks: 
1. Turn your PC on. 
2. Close any applications that are running on your computer. The icons of applications that 

are running appear in the System Tray. It is especially important to close applications that 
use the serial or USB ports of your computer, such as PDAs or digital camera 
applications. 

3. Activate the QuickLink Desktop application that you have already installed during the 
CD-ROM procedure Set Up Product on PC: 

o If, during installation, you chose to add the Desktop to your computer’s startup, 
the Desktop should already be active (see if the Desktop icon appears in the 
system tray at the bottom right side of the screen). 

o If the Desktop application does not run when you start up your computer, or if you 
closed it, you can start it by clicking the Windows Start menu and selecting 
Programs\QuickLink Desktop\QuickLink Desktop. 

4. Open the text file you wish to scan text into. The Pen can send text into any open file with 
an active cursor. For example, activate the Notepad application (click the Windows Start 
menu and select Programs\Accessories\Notepad. 
The Notepad application opens and an “Untitled” file is opened and ready for editing. 

5. Connect the cable to your Pen and PC (the same way you did during the CD-ROM 
procedure Set Up Product on PC). 

Step 2: Prepare the Pen 
Task: 
o Remove the protective cover from the Pen & press  to turn the Pen on. If the Pen 

Main Menu is not displayed, long-press  until it is. 
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The Pen display will show: 

 
The Pen Main Menu 

Task: 
o Press  as many times as necessary until the option Scan to PC appears on the 

screen. 
The Pen display will show: 

 
The Pen Main Menu 

Task: 
o Press  to activate the Scan to PC application. 
The Pen display will show: 

 
The Scan to PC screen 

Step 3: Scan a sentence and send it to the PC 
Task: 
o Scan the first line of the following sentence: 
 

Roll the scanning device over printed words 
and see how the words appear in Notepad. 

 
After the sending is complete, you will see the scanned line in Notepad. The cursor will blink 
right after the text, awaiting additional input. 
Task: 
o Now scan the second line of the above sentence. 
 
The second line appears right after the first line – forming the full sentence. 
Step 4: Return to the Main Menu 
Task: 
o Press  to return to the Pen Main Menu. 
 
 

The Pen Main Menu 
The Pen Main Menu is the menu that appears when not inside any application, menu or 
option. All applications and functions can be accessed from here. When adding on 
applications the Pen – the add on applications are added to this menu. 
 

Accessing the Pen Main Menu 
When initially turning on the Pen it opens in the Pen Main Menu. If you shut the Pen off while 
in an application – then next time you turn on the Pen it will open up in that application. 
o At all times - long-press  to reach the Pen Main Menu. 
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Selecting Options 
To select an application, option or menu from the Pen Main Menu, scroll using   and  
until the desired option appears on the screen, and then press . 
 

The Quicktionary Application 
The primary use of the Quicktionary application is to learn and translate words by viewing 
their definitions from the dictionaries on the Pen. The Quicktionary application also allows 
hearing scanned English lines read aloud, or hearing the English headwords of the dictionary 
entries read aloud, teaching you their correct pronunciation. 
 
The Dictionary screen is the main screen of the application, allowing to view the chosen 
dictionary entries from the dictionaries you installed on your Pen. 
In addition, the Quicktionary application contains the Quicktionary Menu allowing access to 
various options and settings. 
 

Accessing the Quicktionary Application 
1. Long-press  until you reach the Pen Main Menu. 
2. Select the Quicktionary option. 
3. The Quicktionary application starts and the Input Screen appears. This is the first 

screen of the Quicktionary application. From the Input Screen you can simply start 
scanning, or you can access the Quicktionary Menu. 

4. To return to the Pen Main Menu, long-press . 
 

The Dictionaries 
Dictionaries are loaded to the Pen and used by the Quicktionary application. Use the 
Quicktionary application to scan printed words and view the definitions or translations of the 
words - from the dictionary on the Pen. 
 

Dictionary Types 
Most of the dictionaries provided on the CD-ROM are one direction Bi-Lingual dictionaries. 
You will scan the printed text in the source language of the dictionary and you will receive the 
translations - on the Pen screen – in the target language.  
So for example, if you have loaded the French to English dictionary to your Pen – you will scan 
printed French text – and you will be able to read the translations of the scanned words from 
the dictionary – in English. 
 
Other dictionaries may be Mono-Lingual – in which the source and target language are the 
same.  
So for example, if you loaded the AHD Concise dictionary to your Pen – you will scan printed 
English text – and you will be able to read the definitions of the scanned words – from the 
AHD Concise dictionary – in English. 
 

Adding Dictionaries 
To use the Quicktionary application you must have at least one dictionary on the Pen. If no 
dictionaries are installed on the Pen – the application will display an error message “No 
dictionaries on the Pen”. You can add to the Pen as many dictionaries as you have space for. 
Usually there is enough space for 1-2 dictionaries on the Pen. 
 
To add a dictionary to your Pen: 
1. Insert the SuperPen CD-ROM into the CD-ROM drive of your computer. 
2. The Main Menu appears. 

Note: If the Main Menu does not appear automatically, please do the following:  
a. Click the Windows Start button and select Run. 
b. Type x: \setup.exe (where ‘x’ is your CD-ROM drive letter), then click OK. 

3. Click on the Install Add-Ons button. 
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4. The Install Add-Ons menu appears, offering the available add-ons. 
5. Click on the Dictionaries button. 
6. The Dictionaries menu appears, offering the available dictionaries to add to your Pen. 
7. Click on the dictionary you wish to use, and follow the online instructions provided. 
 

The Current Dictionary 
The Quicktionary application utilizes the current dictionary. If one dictionary is installed on the 
Pen – then that dictionary is automatically the current dictionary. If more then one dictionary is 
on the Pen – then the Dictionary menu will contain an additional option “Select Dictionary” 
(see Select Dictionary on page 30) allowing to view which dictionary is the current dictionary – 
and allowing to switch the current dictionary.  
 
Also note that at the top of the Input Screen you will have an indication as to the source 
language of the current dictionary, due to the “Scan in …” message – specifying the language 
of the printed text you should scan. 
 

Deleting Dictionaries 
At times you may find that you have loaded a dictionary that you no longer wish to use, and 
you may want to remove it from the Pen in order to make room for a different dictionary. 
 
Please refer to Add\Remove Pen Components Dialog on page 80 for instructions on launching 
the Add\Remove Pen Components dialog in the Desktop application on your PC. 
 
Important: Deleting components from the Pen is an advanced feature and must be done with 
care. If you feel uncertain, feel free to contact WizCom’s support team (see Contact and 
Support Information on page 7) for guidance. 
 

Dictionary Entries 
A dictionary entry contains various elements and signs. Each dictionary, or even each entry, 
may utilize different elements.  
Following are the main elements and signs: 
Notes: 

o This example shows the Dictionary Screen in reduced display. To set the non-
reduced display, see Reduced Display on page 31. 

o This example shows the first ‘row’ entry from the AHD Concise English to English 
(mono-lingual) dictionary.  

 

 
Dictionary entry elements and signs 

Headword or Multi-word Heading 
The word, term, name, etc. listed in the dictionary and defined in the dictionary entry. 
Headwords appear in the source language of the dictionary – which is the language in which 
you should scan. When the scanned word(s) do not appear in the dictionary as a headword or 
as a multi-word heading (for example when the scanned text is an inflection) then the 
corresponding dictionary entry appears. To pronounce the scanned text, which brought you to 
the definition in the Dictionary Screen (whether it be the actual headword or an inflection), 
press .   
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Homonym number 
The small raised number means that the headword you are viewing is a homonym. 
Homonyms are headwords that are spelled the same way but have different meanings. When 
the scanned word corresponds to two or more identical dictionary entries with separate 
meanings, each meaning is a separate entry with its own number. The Word List will display 
any additional entries, including the homonyms. From the Dictionary Screen - press  to 
view it.  
Part of Speech 
Specifies the part of speech represented by the definition that follows, e.g., verb, adjective, or 
noun. Some dictionary entries contain several parts of speech. Words are used in different 
ways in a sentence. The way a word is used determines its part of speech. The dictionary 
entry is divided into sections for each part of speech (verb, noun, adjective, etc.). 
Word List sign 
The Word List sign ( ) appears to the right of a headword (or multi-word heading) denoting 
that a Word List exists for that headword. The Word List suggests homonyms or additional 
related headwords (for more information, see Long-press  to hear the defined word 
pronounced. 

Press  or  to toggle the display of the current entry - between condensed and full. For 
more information on the display modes, see Viewing Additional Text in the Dictionary Entries 
on page 25. 
Using the Word List on page 28). 
Scroll Arrows 
When scroll arrows appear on the right side of the screen, you can scroll up and/or down in 
the dictionary entry, viewing additional definitions and text. 

o  or  denote that you can scroll down using  
o  or  denote that you can scroll up using .  

o  or  denote that you can scroll up or down using  and . 
o Hollow arrows ( , , ) denote that the Reduced Display is activated. 

o Black arrows ( , , ) denote that the display is currently full (non-reduced display).  
o For more information on the display modes, see Viewing Additional Text in the Dictionary 

Entries on page 25. 
Definitions and Translations 
Definitions and translations are the meaning of the headword. They appear in the target 
language of the dictionary. Each part of speech may have a few meanings. Each meaning 
appears in a separate definition. The definitions are numbered and the first one is the most 
common meaning. Each definition may also have a few sub meanings. Each sub meaning 
appears in a separate sub definition. 
Phonetics 
Phonetics are the phonetic transcription of the headword. Phonetics do not appear in all the 
dictionaries or in all the headwords. Furthermore, phonetics are part of the full display, so if 
they are available - they will appear only when Reduced Display is unchecked. For a guide to 
the phonetic symbols used in the current dictionary, select Pronunciation Guide from the 
Guides & Glossaries option in the Help menu of the Quicktionary Menu (see page 32 for 
instructions). 
Viewing Additional Text in the Dictionary Entries 
Dictionary entries contain various elements and symbols. The basic elements are shown when 
in the default display mode, which is condensed. Additional text elements will appear when 
changing the display to its full mode.  
The default setting of your Pen, displays entries in a condensed style. This means that not all 
of the available information is displayed on the screen, saving you the need to scroll through 
less essential information (such as sample sentences). 
You may either expand the display so that all the additional information is displayed, or 
condense the display so the additional text is hidden. 
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Changing the Display Mode - Condensed and Full 
To change the display mode, set the Reduced Display preference to your liking (refer to 
Reduced Display on page 31 for instructions), or switch the mode – while in the Dictionary 
Screen, as following: 

o In the Dictionary Screen press  or  to toggle the display of the current entry - 
between condensed and full. 

The display of the dictionary entries - in the Word Selection Screen and in the Dictionary 
Screen - will remain in the mode you set – until you change it. 
How do I know if I am in condensed or full mode display? 
At all times (in the Dictionary Screen and also in the Word Selection Screen) - the scroll 
arrow (that appears on the screen when displaying the dictionary entry) will indicate the current 
state of your display: 

o When the scroll arrow is hollow ( ) it means the display is condensed. 
o When the scroll arrow is full ( ) it means the display is full, displaying all the 

available information. 
 
You may also check if the Reduced Display preference is checked or not (see Reduced 
Display on page 31). 
 

The Quicktionary Screens 
 

The Input Screen 
Accessing the Input Screen 
o To access the Input Screen, enter the Quicktionary application from the Pen Main 

Menu. The Input Screen is the first screen of the application. 
o If you are already in the Quicktionary application, you can access the Input Screen by 

pressing  as many times as necessary, till the Input Screen is displayed. 
Using the Input Screen 
On the top of the Input Screen, the ‘Scan in …’ line denotes the source language of the 
current dictionary (see Dictionary Types on page 23) – meaning you should scan printed texts 
in the language specified. The bottom of the Input Screen displays the input field for the text 
you enter. 

 
Input Screen 

Scan in the text you want to define. The Quicktionary application processes the text you have 
scanned and displays its definition in one of two screens - the Word Selection Screen or the 
Dictionary Screen. Both are explained in detail below. 
Manually Entering or Editing Text in the Input Screen 
In the Input Screen (only) - it is possible to manually enter text, using the Character Bar or 
Opticard. 
To access the Character Bar: 
o From the Input Screen, press  to activate the Edit mode (the highlight is removed and 

the cursor appears blinking). 
o Use the arrows to position the cursor where you wish to edit. 
o Press  to open the Character Bar. For further information on the Character Bar, see 

The Character Bar on page 73. Press  to close the Character Bar, and return to the 
input field in Edit mode. Press  twice to return to normal scanning in the Input Screen. 

Note: If some of the text in the input field of the Input Screen is highlighted, press ,  or 
 to de-highlight the text before you begin editing it. Otherwise, the highlighted text will be 

deleted when you begin editing the file. 
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To activate the Opticard: 
Simply scan the Opticard key. The highlight is removed, the cursor appears blinking in the 
input field, and the light at the tip of the Pen blinks rapidly. For further information on the 
Opticard, see The Opticard on page 75. Scan the Opticard key again to return to normal 
scanning in the Input Screen. 
 
Scanning Hyphenated Words 
In the Input Screen, use Edit mode to scan hyphenated words that appear at the end of one 
line and the beginning of the next, such as the word ‘translate’ in the sample sentence below: 
 

Quicktionary enables you to trans- 
late a sentence in seconds. 

 
1. Press  to activate Edit mode. The cursor will be blinking. 
2. Scan the first line. 
3. With the text you have just scanned still highlighted, scan the second line. 
 

The Word Selection Screen 
Accessing the Word Selection Screen 
o After scanning or entering text that contains more than one word – the Word Selection 

Screen automatically appears. 
o If you navigated from the Word Selection Screen to the Dictionary Screen, press  to 

return to the Word Selection Screen. 
Using the Word Selection Screen 
The Word Selection Screen is split into two sections. The upper section displays the 
scanned text. The lower section displays the dictionary entry corresponding to the selected 
word in the scanned text above (for more about dictionary entries, see Dictionary Entries on 
page 24). 
 

 

 
The Word Selection Screen 

1. Press  and  to scroll forward and backward through the scanned text. A right scroll 
arrow at the end of the text indicates that you can scroll to the right to view the 
continuation of the text. When you scroll right, the left scroll arrow indicates that you can 
scroll left to view the previous section of the text. The dictionary entry for each highlighted 
word appears in the lower screen.  
Notes:  
o At times, the highlighted word is the first word of a multi-word heading.  
o If the highlighted word is an inflection or derivative of a dictionary entry, the 

corresponding dictionary entry appears.  
o If the highlighted word is the first word in an idiom (and the current dictionary contains 

an idiom index), the idiom appears. 
o If the scanned image is incomplete or unclear, the bottom half of the Word Selection 

Screen will display a list suggesting various possible spellings  from which you can 
choose. Press  and  to scroll the list. Press  to select the highlighted 
suggestion. 
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If Auto Speak is activated (see Auto Speak on page 31), Quicktionary pronounces each 
word as it is highlighted.  
Note: If you scroll left to the Voice icon , the Quicktionary application pronounces 
the entire line of text. 
 

2. Press  and  to scroll through the definitions in the lower section of the screen. The 
scroll arrows to the right of the dictionary entry indicate in which direction you can scroll to 
view more of the definition. 

3. To view the dictionary entry in a full screen (without the scanned text), press . The 
Dictionary Screen appears. 

 
You can scan new text while in the Word Selection Screen. The current text is overwritten. 
 

The Dictionary Screen 
Accessing the Dictionary Screen 
The Dictionary Screen can be accessed from many places. 
o When scanning or entering a single word – the Dictionary Screen automatically appears 

displaying the dictionary entry for that word. 
o From the Word Selection Screen, press  to display the definition of the highlighted 

word in the Dictionary Screen. 
o When selecting words from the lists (History or Adjacent Entries) their definitions are 

displayed in the Dictionary Screen. 
Using the Dictionary Screen 
o Press  and  to scroll through the definitions or translations of the entry. The scroll 

arrows to the right of the dictionary entry indicate in which direction you can scroll to view 
more of the definition. 

o Long-press  and  to hop between the definitions. 
o Double-click  and  to hop between parts of speech. 
o Long-press  to hear the defined word pronounced. 
o Press  or  to toggle the display of the current entry - between condensed and full. 

For more information on the display modes, see Viewing Additional Text in the Dictionary 
Entries on page 25. 

Using the Word List 
The Word List contains additional or alternative dictionary entries available for the current 
scanned text or headword (or multi-word heading). Word Lists are created when: 
o The scanned word corresponds to more than one dictionary entry. For example, if you 

scan the word ‘dressing,’ the Quicktionary application enables you to choose between 
the dictionary entries ‘dress’ and ‘dressing’. 

o The scanned word (e.g., row) corresponds to two or more identical dictionary entries with 
separate meanings (i.e., homonyms). 

o When an idiom (or phrasal verb) is scanned, and that idiom is part of the idiom index of 
the current dictionary (Note: not all dictionaries contain an idiom index), then highlighting 
the first word of the idiom will display the definition of the idiom and not of the highlighted 
word. The entry for the highlighted word will appear in the Word List. 

 

The Word List sign ( ) appears to the right of the headword (or multi-word heading) 
denoting that a Word List exists for that headword. The Word List sign appears in the entries 
- that are displayed both in the Word Selection Screen and in the Dictionary Screen – but 
the list is accessible only from the Dictionary Screen. 

 
Entry ‘row1’ in Dictionary Screen 
demonstrating the Word List sign 
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When the Word List sign appears – press  from the Dictionary Screen to view the list. 
The headword you came from will appear highlighted. Additional headwords will appear. 

 
Word List for ‘row’ 

o Press  and  to scroll the list.  
o Press  to view the definition of the highlighted entry – in the Dictionary Screen. 
Note: If the scanned image is incomplete or unclear, Quicktionary will automatically display a 
different kind of word list – in the bottom half of the Word Selection Screen. This list suggests 
various possible spellings (as opposed to additional entries) from which you can choose. 
Press  and  to scroll the list. Press  to select the highlighted suggestion. 
 

Obtaining Words to Define 
The main way to obtain words you wish to define is by scanning them. So for example, when 
you read an article or book, and encounter an unclear word – simply scan it. Them use the 
Quicktionary application and its dictionaries to define and learn the word. 
There are 4 ways to obtain words to define: 
o Scanning – this is the major way. You can scan new text when in any of the Quicktionary 

screens: the Input Screen, the Word Selection Screen or the Dictionary Screen. 
o Choose a word from the Adjacent Entries list (see Adjacent Entries on page 30). 
o Choose a word from the History (see History on page 30).  
o Manually enter or edit text in the input field of the Input Screen - using the Character Bar 

or Opticard (see Manually Entering or Editing Text in the Input Screen on page 26). 
 

Hearing the Pen Read Words Aloud 
The Quicktionary application includes a Text to Speech engine allowing the speaking out 
(hear the pronunciation) of the scanned words or of several definition elements. The Voice 
Settings for Volume, Pitch and Reading Speed (see Voice Settings on page 67) are set 
from the Preferences menu in the Pen Main Menu. The Auto Speak option (see Auto Speak 
on page 31), set in the Preferences menu of the Quicktionary application, indicates if certain 
elements are spoken out automatically, or not (i.e., if the option is not on, you can still speak 
out the words voluntarily, as explained ahead).  
In the Word Selection Screen 
When Auto Speak is activated:  
Press  and  to scroll forward and backward through the scanned text. Quicktionary 
pronounces each word as it is highlighted.  
When Auto Speak is not activated: 
Press  till the Voice icon  is highlighted. Quicktionary application pronounces the 
entire line of scanned text. While the icon is highlighted, pressing  or  will pronounce 
the entire line again. 
In the Dictionary Screen 
When Auto Speak is activated:  
When entering the Dictionary Screen, the scanned word (or words) whose definition is 
displayed, are pronounced. For example, if you scan the word ‘reduce’, which is a headword, 
then, when entering the Dictionary Screen, the word ‘reduce’ will be pronounced and the 
definition of ‘reduce’ will be displayed. On the other hand, if you scan the word ‘reduced’, 
which is not a headword, but rather an inflection of one, the word ‘reduced’ will be pronounced 
whereas the definition of ‘reduce’ will be displayed. Long-Press  to hear the word(s) 
pronounced again. 
When Auto Speak is not activated: 
In the Dictionary Screen, Long-Press  to hear the scanned word(s) (whose definition is 
displayed) or headword, pronounced. 
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Homograph Pronunciation 
A homograph is a word that has more than one pronunciation with a corresponding separate 
meaning. If the Pen is about to pronounce a word which is a homograph, Quicktionary 
speaks out the different pronunciations of the word, separated by a spoken “or”. 
For example, if you scan the word “Convict”, it will be spoken out as “Convict or Convict” – 
where the first instance is a pronunciation of the verb convict (meaning “To find or prove 
guilty of an offense or crime”) and the second is a pronunciation of the noun convict (meaning 
“A person found guilty of a crime, esp. one serving a prison sentence.”). 
 

The Quicktionary Menu 
 

Accessing the Quicktionary Menu 
1. To display the Quicktionary Menu, press  from the Input Screen. 
2. To return to the Input Screen, press . 
 

The Quicktionary Menu Options 
The Quicktionary Menu contains four menu options. Following is their description. 
Dictionary 
The Dictionary menu contains a series of dictionary tools.  
1. To access the Dictionary menu, select Dictionary from the Quicktionary menu.  
2. To return to the Quicktionary Menu press . 
The Dictionary menu contains the following options: 
History  
This option displays a list of the most recently defined words for all dictionaries on the Pen, 
with the last word you defined at the top of the list. The History list can store up to 80 words. 
Once the list is full, the oldest word is deleted from the list to make room for the most recent 
one. 
To view the definition of an entry from the list: 
1. Select History from the Dictionary menu. 
2. Press  and  to scroll through the list, till the entry you want is highlighted. 
3. Press . The dictionary entry appears in the Dictionary Screen. 
4. Press  to return to the history list. 
5. Press  again to return to the Dictionary menu. 
Adjacent Entries 
This option displays a combined list of all headwords or multi-word headings of the current 
dictionary.  
To view the definition of an entry from the list: 
1. Select Adjacent Entries from the Dictionary menu. 
2. The list is displayed. When displaying the list, you are placed at the location of the last 

entry you viewed. If you haven’t viewed a definition during the current session, you are 
placed at the beginning of the list. 

3. Press  and  to scroll through the list, till the entry you want is highlighted. 
4. Press  to view the definition of the selected entry in the Dictionary Screen. 
5. Press  to return to the Adjacent Entries list. 
6. Press  to return to the Dictionary menu and again to return to the Quicktionary 

Menu. 
Select Dictionary 
Select this option to view the list of dictionaries installed on the Pen, view the one set as the 
current dictionary, and change the current dictionary.  
Note: this option will appear only if the Pen contains more than one dictionary. 
1. Select Select Dictionary from the Dictionary menu 
2. The list of all dictionaries installed on the Pen is displayed. The highlighted option is the 

current dictionary.  
3. Press  and  to scroll through the list, till the dictionary you wish to set as the current 

dictionary - is highlighted. 
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4. After closing the message, the Pen returns to the Input Screen.  
Reset History 
Select this option to erase all entries from the History list.  
5. Select Reset History from the Dictionary menu 
6. A confirmation question appears.  
7. After closing the message, the Pen returns to the Input Screen.  
Preferences 
The Preferences menu contains options for adjusting dictionary features for your 
Quicktionary application. You can change more than one preference at a time.  
1. To access the Preferences menu, select Preferences from the Quicktionary menu.  
2. Once you have changed the preferences, press  to return to the Quicktionary Menu 

and save the changes. 
3. You cannot undo changes – so make sure that when pressing  to exit the 

Preferences menu – all settings are set as you want them. 
The Preferences menu contains the following options: 
Inverse 
Use this preference when scanning inverse text (light-colored text on a dark background). 
Otherwise this option should not be selected. 
o To toggle the Inverse option on or off, press ,  or . When a check mark (�) 

appears at the left of the option – the option is activated, when no check mark appears – 
the option is not activated.  

o When pressing  to exit the Preferences menu – the settings are automatically saved. 
When the Inverse option is activated an  appears in the upper-right corner of the Input 
Screen, indicating that the device is in inverse mode. When inverse text mode is selected, the 
red light in the tip of Pen blinks rapidly. 
 

 
  Input Screen in inverse scanning mode 

Reduced Display 
This preference determines whether display elements in the dictionary, such as phonetics, 
appear with the definition. When Reduced Display is selected, certain display elements are 
hidden. When it is not – the full definition is displayed.  
o To toggle the Reduced Display option on or off, press ,  or . When a check 

mark (�) appears at the left of the option – the option is activated, when no check mark 
appears – the option is not activated.  

o When pressing  to exit the Preferences menu – the settings are automatically saved. 
Note: You can also toggle the Reduced Display on or off when in the Dictionary Screen, by 
pressing  or . 

Auto Speak 
When Auto Speak is selected, the Quicktionary application pronounces each word in the 
dictionary the moment you select it for defining (for more information, see Hearing the Pen 
Read Words Aloud on page 29).  
o To toggle Auto Speak on or off, press , , or . When a check mark (�) appears 

at the left of the option – the option is activated, when no check mark appears – the option 
is not activated. 

o When pressing  to exit the Preferences menu – the settings are automatically saved. 
Line(s) Per Scroll 
This preference determines how many lines the Quicktionary application scrolls at a time in 
the Dictionary Screen.  
o To change the number of lines per scroll, press  or . The Quicktionary application 

can scroll one, two, or three lines at a time.  
o When pressing  to exit the Preferences menu – the settings are automatically saved. 
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Help 
The Help menu contains options that display information about the dictionary. 
1. To access the Help menu, select Help from the Quicktionary menu.  
2. To return to the Quicktionary Menu press . 
The Help menu contains the following options: 
Guides & Glossaries 
This menu contains guides with information that can help understand various elements used 
in the current dictionary. Note: Each dictionary may have different guides available. 
1. To view the Guides & Glossaries menu, select Guides & Glossaries from the Help 

menu. 
2. Press  to return to the Help menu. 
Pronunciation Guide 
The Pronunciation Guide displays a list of symbols used for the phonetic transcription 
displayed after each dictionary entry.  
Next to each symbol is an example of how it is pronounced.  
Note: Not all dictionaries include this Guide. 
1. To view the Pronunciation Guide, select Pronunciation Guide from the Guides & 

Glossaries menu. 
2. Scroll through the list, using  or . 
3. Press  to return to the Guides & Glossaries menu. 
Abbreviations Guide 
This option displays a list of abbreviations used in the current dictionary, and displays the word 
to which each abbreviation in the list refers. 
Note: Not all dictionaries include this Guide. 
1. To view the Abbreviations Guide, select Abbreviations Guide from the Guides & 

Glossaries menu. 
2. Scroll through the list, using  or . 
3. Press  to return to the Guides & Glossaries menu. 
Symbol Guide 
The Symbol Guide lists the symbols used in the dictionary and what each symbol denotes. 
Note: Not all dictionaries include this Guide. 
1. To view the Symbol Guide, select Symbol Guide from the Guides & Glossaries menu. 
2. Scroll through the list, using  or . 
3. Press  to return to the Guides & Glossaries menu. 
About 
The About option displays information about Quicktionary, the professional dictionaries and 
the text-to-speech software used for reading aloud texts. 
 
Pen Main Menu 
Select this option to display the Main Menu. Long-Pressing the  at any time will display the 
Main Menu, too. 
 

The Quicktionary Edit Menu 
The Edit Menu contains additional options which affect the editing of the text in the input field 
of the Input Screen. 
 

Accessing the Quicktionary Edit Menu 
Note: In the Quicktionary application, the Edit Menu is available only from the Input Screen.  
1. Access the Input Screen (see Accessing the Input Screen on page 26). 
2. Press  to remove the highlight. A blinking cursor will appear. You are now in Edit 

mode. 
3. Press  to access the Edit Menu of the application. 
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The Quicktionary Edit menu Options 
Resume Editing 
Select this option to close the Edit Menu and return to the text. 
Activate Overwrite Mode/Activate Insert Mode 
This toggle option is a general option relating to the usage of the Character Bar. For 
information on this option, see Insert Mode and Overwrite Mode on page 73 in ‘The Character 
Bar’ section of this manual. 
Clear Text 
Select Clear to delete the text from the Input Screen. The Quicktionary application returns to 
the Input Screen, in Edit Mode. 
 

Exiting the Quicktionary Application 
Long-press  until you reach the Pen Main Menu. 
 
 

The Notes Application 
The Notes application is used to scan and store notes and excerpts into text files. Once you 
have stored a file on the Pen, you can transfer it to your computer using the QuickLink option 
(from the Pen’s Main Menu) or to a PDA by selecting Beaming from the application menu. 
 

Accessing the Notes Application 
1. Long-press  until you reach the Pen Main Menu. 
2. Select the Notes option. 
3. The Notes application starts and its main menu appears. 
 

Creating and Opening Notes Files 
From the Notes Main Menu, select any of the following options: 
o Select Edit Current File to open the current file. The ‘current’ file is the one whose name 

appears in the caption of this menu. If no file is currently open, the message No Open 
File appears in the caption. In this case, selecting Edit Current File will first show the 
message No Open File and then show the Enter file name dialog box, suggesting a new 
file name. 

o Select New File to create a new file and then open it. The Enter file name screen will first 
appear suggesting a default file name. 

o Select Open File to select an existing file and open it. A list will first appear suggesting all 
available files. 

The file opens and the blinking cursor indicates the point at which text will be inserted. 
 

Editing Notes Files 
 

Easy Steps 
1. Create or open a file (see above). The cursor appears blinking at the beginning of the file 

(if it is a new file) or at the place it was when you previously closed this file (when it is not a 
new file). 

2. Scan in a line of English text. Note: if you want to scan text that is in a different language, 
see Select Language on page 36 If you want to scan numeric or inverse text, see 
Scanning Options on page 72. 

3. The new text appears on the screen at the cursor point and the new text is highlighted.  
4. If the scanning result on the screen is not satisfactory (see Poor Character Recognition on 

page 13) and you would like to try and rescan it – then please press  first to delete the 
highlighted text - and then scan the line again. 
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5. When scanning continuously, each successive line of text you scan is entered into the file 
as a continuation of the previous line with a space inserted after the last word of the 
previously scanned text. 

6. Press  to insert a new paragraph into the file. 
7. If you wish to edit existing text, add on to it, or delete part of it, you can: 

o Scan: Press ,  or  to de-highlight the text and position the cursor. Any 
scanned text will appear at the cursor position with spaces on each side. 

o Delete: press  to delete highlighted text. After scanning in text – the new text 
appears highlighted – to allow this quick deletion of the latest scan. 

o Use Character Bar: press ,  or  to de-highlight the text and position the 
cursor and then double-click  to display the Character Bar (see The Character 
Bar on page 73). 

o Use Opticard: press ,  or  to de-highlight the text and position the cursor 
and then scan the Opticard key on the Opticard and begin scanning Opticard keys 
as needed (see The Opticard on page 75). 

o Use the Edit Menu: press  to access the Edit Menu (see The Notes Edit 
Menu on page 36). 

 

Navigation Shortcuts Within a File 
Double-clicking the arrow buttons quickly moves the cursor around an open file: 

Double-click this button To move the cursor to  

 The beginning of the file 

 The end of the file 

 The left edge of the current line. 

 The right edge of the current line. 
 

Scanning in Other Languages 
Please refer to Select Language on page 36. 
 

Closing and Saving Notes Files 
When inside an open Notes file, press  twice to close the file. The text is saved in the file. 
 

Beaming Notes to and from a PDA 
Please refer to Beaming on page 35. 
 

The Notes Menu Options 
 

The Notes Main Menu 
The Main Menu contains the high level options of the Notes application. 
Accessing the Main Menu 
To access the main menu of the application, select Notes from the Pen Main Menu. When 
already in the Notes application press  to reach the Notes Main Menu. 
Following is a description of the Main Menu options: 
Main Menu Caption – Current File 
The caption of the Notes Main Menu displays the current file. If no file is open – the caption 
displays “No Open File”. 
Edit Current File 
To edit the current file. 
1. Select Edit Current File. The ‘current’ file is the last file you worked on - whose name is 

displayed in the caption of the Notes Main Menu. 
2. The file is opened and the cursor appears in the last position it was at the last time you 

edited this file. 
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3. The file is ready for editing. See Editing Notes Files on page 33 for information on editing 
stored files. 

New File 
To create a new file:  
1. Select New File. The Enter file name dialog box opens with an automatically generated 

name displayed in the file name field, in Scan mode (no blinking cursor). 
Notes: 
o Editing the File Name: If you want to edit the file name you can scan in a new 

name (which will overwrite the highlighted text) or edit the file name manually by 
pressing  once to enter Edit mode and then you can do any following: press 

 to display the Character Bar (see The Character Bar on page 73) or scan the 
Opticard key to activate the Opticard (see The Opticard on page 75). You may 
also press  to access the file name Edit Menu (this menu contains options 
specifically for editing file names, see The File Name Edit Menu on page 72). 

o Resetting to the default file name: to reset the file name to the default file name 
with the lowest counter available on the Pen (for example “note001”) – press . 
The Reset default file name? question appears. Press  to select YES and 
confirm the resetting. Warning: If you reset the file name and create a file with a 
name you have already sent to the PC – next time you QuickLink the files to the 
PC – the old file on the PC will be overwritten with the new file that has the same 
name. 

2. Press  to highlight the OK button and press  to open the new file. 
3. The cursor will appear at the beginning of the new file. 
4. The file is ready for editing. See Editing Notes Files on page 33 for information on editing 

stored files. 
Open File 
To open an existing stored file: 
1. Select Open File. A list of existing files appears. 
2. Select the file you want to open. 
3. The cursor will appear at the end of the file. 
4. The file is ready for editing. See Editing Notes Files on page 33 for information on editing 

stored files. 
Delete File 
To delete an existing stored file: 
1. Select Delete File. 
2. Select the file you want to delete. 
3. Select YES when the confirmation message appears. 
Beaming 
Sends and receives stored files using Infra-Red communications. You can use this option to 
send a file to an IrOBEX-compliant device like a PDA or a smart phone or to receive a file 
from such a device and save it in a file on your Pen. 
Note: The Communications Settings are not used for the Beaming functions. 
Send Note 
1. Make sure the device is ready to receive the file. 
2. Select the file to send to the device.  

Note: The Pen always sends the current file. The name of the current file is displayed 
at the top of the Notes Main Menu. 
To select a different file:  

a. Select Open File from the Notes Main Menu. 
b. Select the desired file from the list of files on your Pen. The selected file is 

now the ‘current’ file. 
3. Select Beaming. The Beaming submenu opens. 
4. Select Send Note. The Pen displays a “Sent successfully” message if the file was sent, or 

an error message if the transfer failed. 
Note: To use the Beaming features you must align the IR ports of the two devices. The IR 
port is located at the bottom of the Pen. 
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Receive Note 
1. Select Beaming. The Beaming submenu opens. 
2. Select Receive Note. 
3. Send the note. When the Pen receives the note, it displays the message "Received 

successfully." 
Note: To use the Beaming features you must align the IR ports of the two devices. The IR 
port is located at the bottom of the Pen. 
Exit 
Exits the Notes application and returns to the Pen Main Menu. 
 

The Notes Edit Menu 
The Edit Menu contains additional options which affect the editing of the current open file. 
Note: an additional Edit Menu is available from the Enter file name dialog box with options for 
editing the file name (see The File Name Edit Menu on page 72). 
Accessing the Edit Menu 
When inside an open Notes file (see Creating and Opening Notes Files on page 33) - press 

 once to access the Edit Menu of the application.  
Following is a description of the Edit Menu options: 
Resume Editing 
Select this option to close the Edit Menu and return to the text. 
Activate Overwrite Mode/Activate Insert Mode 
This toggle option is a general option relating to the usage of the Character Bar. For 
information on this option, see Insert Mode and Overwrite Mode on page 73 in ‘The Character 
Bar’ section of this manual. 
New Paragraph 
Inserts a new paragraph between two paragraphs. 
1. Place the cursor on the paragraph you want the new paragraph to follow. 
2. Press  to open the Edit Menu. Note: If the cursor is at the end of the last paragraph 

(and not between 2 existing paragraphs) – you could simply press  to add a new 
paragraph. 

3. Select New Paragraph. A new paragraph is inserted after the selected paragraph (it 
appears after a separating line) and the cursor is positioned at the beginning of the new 
paragraph. 

Delete Paragraph 
Deletes a paragraph.  
1. Place the cursor on the paragraph you want to delete. 
2. Press  to open the Edit Menu. 
3. Select Delete Paragraph. 
4. The cursor will appear at the end of the previous paragraph. 
Select Language 
Use this option to change the scanning language if the material you are scanning is a 
language other than English (which is the default). It is also advised to add a speller for that 
language, to enhance the recognition (see Adding Spellers on page 71). When the Scanning 
Language setting matches the language of the printed text, and a speller for that language is 
installed on the Pen – the scanning results are optimal. 
Important: 
This setting affects the future scanning into the current file only. This may be useful when 
scanning different languages into one file. If you wish to change the general setting of the Pen, 
which will affect all new files created on the Pen- in all of the applications, then please change 
the scanning language in the Scanning Language option in the Preferences menu of the 
Pen Main Menu (see Scanning Language on page 66). 
To select a scanning language: 
1. Open a new paragraph. Note: You cannot change the scanning language if text already 

exists in the current paragraph. Open a new paragraph before you change the scanning 
language. Otherwise, the Pen will ask you to delete the existing text. 
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2. Press  to open the Edit Menu. 
3. Select the Select Language option. The current language appears highlighted. 
4. Select the language you want. 
5. This setting affects future scanning into the current file only. Any new file created will be 

set to the scanning language that is set in the Scanning Language option in the 
Preferences menu of the Pen Main Menu. 

Scanning Options 
Allows setting the Pen for scanning inverse text (bright text on dark background) and/or text 
that is all digits. 
1. Press  to access the Edit Menu. 
2. Select Scanning Options.  
3. Press , , or  to toggle an option on or off. A checkmark (�) is displayed when the 

option is on.  
4. Press  to close the Scanning Options, save your settings and return to the open file. 
5. These settings affect editing in the current file only (i.e., if you create a new file, or even if 

you open a different file and then return to this file - these settings return to their default – 
which is off). 

 

Exiting the Notes Application 
Long-press  until you reach the Pen Main Menu. 
 

QuickLink the Notes 
Important: 
Transfer of stored file info between the Pen and PC requires Pen-PC Communications. 
Therefore, you must have already run the one time procedure Set Up Product on PC from 
the SuperPen CD-ROM. If you have not yet done this, please refer to Set Up Product on PC 
on page 9, and follow the instructions there. 
 
Following are short instructions for sending stored Notes files to the PC. For more information 
please refer to Tutorial 3 – QuickLink on page 18 and to The QuickLink Function on page 56). 
 
1. Turn your PC on. 
2. Make sure that your Pen and PC are connected. 
3. Start the QuickLink Desktop application and make sure that Pen communications are 

on. 
4. Turn the Pen on. 
5. From the Pen Main Menu select QuickLink The sending begins. 
6. When the process is done, OK the pop up in the QuickLink Desktop. 
7. Click the Notes icon in the QuickLink Desktop application. 
8. The list of Notes files you transferred from the Pen - appear on screen. 
 
Notes: 
o By default, the stored files of the Notes application are copied from the Pen to the 

Desktop application and then deleted from the Pen. See QuickLink Settings for the Notes 
application on page 60 for information on changing these settings or having the files sent 
to additional PC applications such as MS Word. 

o When performing QuickLink - all stored files (from all QuickLink applications) on your Pen 
are sent to the PC, according to the QuickLink Settings set in the Desktop application 
(see Setting the QuickLink Settings in the Desktop on page 57) 
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The Address Book Application 
In the Address Book application you can store information in entries containing name, 
address, phone number and other contact information. 
 

Accessing the Address Book Application 
1. Long-press  to reach the Pen Main Menu. 
2. Select the Address Book option. 
3. The Address Book application starts, and its Main Menu appears. 
 

Creating and Opening Addresses 
To create a new address: 
1. From the Address Book Main Menu, select New Address. 
2. A new address is created and opened for editing (in Scan mode, see Scan Mode on page 

39). 
To open an existing address: 
1. From the Address Book Main Menu, select View Addresses. 
2. Scroll and highlight the address you wish to open for editing. 
3. Press . 
4. Select Edit Address. 
5. The address is opened, displaying its text (in Scan mode, see Scan Mode on page 39). 

You can now edit the address. 
 

Editing Addresses 
 

Easy Steps 
1. Create or open an address (see above). The First Name field appears and the file is in 

Scan mode (see Scan Mode on page 39) – meaning you can simply start scanning, and 
the fields will accept the scanned text. 

2. Scan in the first name of the contact information you want to store (for example, from a 
business card). The Pen is set for scanning English text. Note: if you want to scan text 
that is in a different language, see Next Address Lang. on page 41. If you want to scan 
numeric or inverse text, or if you want a field to contain more than one line, see Scanning 
Options on page 45. 

3. The first name you have scanned is placed in the First Name field (highlighted) and the 
Pen automatically advances to the next field which is Last Name (see on Auto Advance 
page 41). 

4. Continue scanning information into the entry fields. To skip a field, press .  
Note: By default, the Address and Notes fields are in Multiple Lines mode (see Field 
Settings, p. 42) 

5. If the scanning results on the screen are not satisfactory (see Poor Character Recognition 
on page 13), you can edit the cell in various ways - see Editing Existing Text on page 38. 

6. When you have finished filling the fields, either select the OK button at the bottom of the 
entry, or press  (once – if in Scan mode, three times if in Edit mode).  

7. The contact information you have just scanned is saved to your Pen as one new address 
entry. The Address Book Main Menu is displayed. 
Note: If the information you have scanned exceeds the width of the Pen display, you can 
see the entire text by viewing the address (see View Address on page 41). 

 

Editing Existing Text 
There are 2 modes for editing existing text – Scan mode and Edit Mode. The mode affects the 
editing of the current field - meaning you must currently be in an open field. 
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Scan Mode 
This is the default mode in the Address Book application. When the current field is in Scan 
mode, scanning new text will delete any text from the whole field (if existing) and replace it 
with the new text you have scanned. This is useful for rescanning the whole field. 
Edit Mode 
When the current field is in Edit mode, you can do any following: 
�� Insert Text: Scan new text you want to insert into the current field. Please scan whole 

words and not single characters (for single character editing use the Character Bar or the 
Opticard). The new text is inserted where the cursor was positioned, and spaces are 
added to create correct word separation within the line of text. To quickly undo this new 
scan, simply press . This will delete the new scan which initially appeared highlighted 
(it is highlighted to allow this quick undoing). If you do not want to undo the new scan, 
press the arrow buttons to de-highlight the text, before entering more text. 

�� Use the Edit Menu: press  to access the Address Book Edit Menu (see The 
Address Book Edit Menu on page 44). 

�� Use the Character Bar: Press  to display the Character Bar (see The Character Bar 
on page 73) and edit the point at which the cursor is inserted. 

�� Use the Opticard: Scan the Opticard key to activate the Opticard (see The Opticard on 
page 75) and edit the point at which the cursor is inserted. 

How to know which mode the Pen is in 
�� In Scan mode the whole field appears with a black background and all the text is green. 

There is no blinking cursor.  
�� In Edit mode there is a blinking cursor in the current field.  
Switching between Scan mode and Edit mode 
�� If you are in Scan mode (no blinking cursor, field background is black), press  to 

switch to Edit mode. 
�� If you are in Edit mode (blinking cursor), press  twice to switch to Scan mode. 
 

Navigation Shortcuts 
Double-clicking the arrow buttons quickly moves the cursor within the current field of an 
address entry (when the cursor is blinking in Edit mode). 

Double-click 
this button 

To move the cursor to:  

 
The beginning of the field 

 
The end of the field 

Scanning in Different Languages 
Please refer to Next Address Lang. on page 41. 
 

Closing and Saving Addresses 
When editing an address, scroll to the OK button and press  to close the address. Its 
contents are saved and the Address Book Main Menu appears. 
You may also press  in which case the Save changes? message will appear (note that if 
you were in Edit mode, the Edit Menu will appear. Press .to close it, and press  again 
to reach the Save changes? message): 
�� If you chose YES, the address closes, its contents are saved and the Address Book 

Main Menu appears. 
�� If you chose NO, the address closes, its contents are not saved and the Address Book 

Main Menu appears. 
�� If you chose CANCEL, you are brought back to the field you were editing. 
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Viewing Addresses 
Please refer to View Addresses on page 40 and View Address on page 41. 
 

Beaming Stored Addresses to a PDA 
Please refer to Beaming on page 43. 
 

The Address Book Menu Options 
 

The Address Book Main Menu 
Accessing the Main Menu 
To access the application’s main menu, select Address Book from the Pen Main Menu. 
When already in the menu options of the Address Book, press  to return to the Address 
Book Main Menu. When editing an address entry, see Closing and Saving Addresses on 
page 39 for instructions on returning to the main menu. 
Following is a description of the Address Book Main Menu options: 
Main Menu Caption – Current File 
The caption of the Address Book Main Menu displays the name of the main address book 
file ‘File: mainadd’. This is the current file. 
New Address 
Select this option to scan in a new Address Book entry.  
1. Select New Address. 
2. A new address opens and the first field appears in Scan mode. 
3. The address is ready for editing. See Editing Addresses on page 38 for information on 

editing addresses. 
View Addresses 
Select this option to view the Address Book entries that are on your Pen: 
� Select View Addresses. A list appears consisting of Last Name , First Name of all 

addresses in the current Address Book file. 
The Addresses Menu 
When in the View Addresses list, it is possible to access the Addresses Menu which 
contains options for finding, deleting, viewing, and editing specific addresses from the list. 
Accessing the Addresses Menu 
1. From the Address Book Main Menu, select View Addresses. 
2. Press  to open the menu. Note: To delete, view, or edit a particular address in the list, 

scroll to that address and then press . 
The following options are available in the Addresses Menu: 
Find Address 
Select this option to narrow the search for a specific address when you have a long list of 
Addresses. 
1. Press  from anywhere in the View Addresses list to access the Addresses Menu. 
2. Select Find Address. The Character Bar appears. 
3. Press  or  to scroll to the first letter in the address entry (e.g., the 'S' in Smith). The 

cursor jumps to the first entry in the list beginning with that letter. 
4. Press , and scroll to the second letter in the entry (e.g., the 'm' in Smith). The cursor 

jumps to the first entry in the list beginning with those two letters. 
5. Press  and scroll to the third letter in the entry, if necessary. 
6. When you find the address you want, press  to exit the Character Bar. 
7. Press  to select the found address. 
Select Search Language 
Select this option to change the search language for the above Find Address command. 
1. Press  from anywhere in the View Addresses list to access the Addresses Menu. 
2. Select the Select Search Language option. 
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3. Select the language you want. 
Delete Address 
Select this option to delete the current address. 
1. In the View Addresses list scroll to the address you want to delete (until it is highlighted). 
2. Press  to access the Addresses Menu. 
3. Select Delete Address. 
4. When the confirmation appears, select YES. 
View Address 
Select this option to view the current address. 
1. In the View Addresses list scroll to the address you want to view (until it is highlighted). 
2. Press  or press  to access the Addresses Menu and then select View Address. 
3. The address is displayed in View mode, i.e. you can scroll through the address fields but 

you cannot make any changes. 
Edit Address 
Select this option to edit the current address. 
1. In the View Addresses list scroll to the address you want to edit (until it is highlighted). 
2. Press  twice or press  to access the Addresses Menu and then select Edit 

Address. 
3. The address opens and the first field appears in Scan mode. 
4. The address is ready for editing. See Editing Addresses on page 38 for information on 

editing addresses. 
Settings 
The Settings submenu lets you customize the way Address Book entries are created. You 
can use it to set a variety of options, from selecting the fields you would like included in each 
Address Book entry, to setting scanning and display options.  
Accessing the Settings Menu 
From the Address Book Main Menu select Settings. 
You can change more than one setting at a time. Once you have changed the settings, press 

 to return to the Address Book Main Menu. 
The Settings menu contains the following options: 
Scroll Screen 
When Scroll Screen is selected, the display scrolls, rather than jumps, to the following field 
each time you finish scanning a line. This is the default.  
To toggle Scroll Screen on or off, press , , or . A checkmark (�) is displayed when it 
is on. 
Auto Advance 
When Auto Advance is selected, the display moves automatically to the next field when you 
finish scanning a line. This is the default. When Auto Advance is not selected, you must scroll 
manually from field to field after scanning in information by pressing .  
To toggle Auto Advance on or off, press , , or . A checkmark (�) is displayed when 
it is on. 
AutoName 
Select AutoName so that you can scan in both the first and last names at the same time. 
Automatically, the first name appears in the First Name field, and the last name appears in 
the Last Name field. 
To toggle AutoName on or off, press , , or . A checkmark (�) is displayed when it is 
on. 
Next Address Lang. 
Note: The Next Address Lang. option appears only if scanning languages have been added 
to the Pen (see Adding Spellers on page 71). If none have been added, the Pen is preset for 
scanning English text. 
Use this option to change the scanning language in the Address Book if the material you are 
about to scan is in a different language than the current setting. When the Next Address 
Lang. setting matches the language of the printed text, the scanning results are optimal, since 
a spelling check for that specific language is performed. 
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Important: 
This setting affects the scanning language of all future scanning into the Address Book 
application. If you wish to change the general setting of the Pen, which will affect all new files 
created on the Pen- in all of the applications, then please change the scanning language in the 
Set Scanning Language option in the Settings menu of the Pen Main Menu (See Scanning 
Language on page 66). 
To change the language prior to creating the new address: 
1. Select Next Address Lang.. 
2. Select the language you want. 

Note: the E-mail and Web Page fields are not affected by the change in language. 
Select Fields 
Select the Select Fields option to choose the fields you want in each address entry. You can 
choose any or all of the following fields: 

Title E-mail 
Company Web Page 
Address Home Phone 
Business Phone Home Fax 
Business Fax Notes 
Mobile phone   

Notes: 
�� By default, all of the fields are selected. 
�� The First Name and Last Name are mandatory for an address entry. 
To select or de-select a field:  
1. Select the Select Fields option. 
2. Scroll to the field until it is highlighted. 
3. Press , , or . A checkmark (�) is displayed when the field is selected. 
Field Settings 
Select the Field Settings option to change the default scanning options that will be set for 
each type of field when it is created. Adjusting these settings can increase scanning accuracy. 
For example, you might choose the Numeric field setting for the Business Phone field, 
because all of the characters that you scan into this field are numerals. 
The following scanning options are available for each field. You can select any or all of these 
settings for each field. 
�� Numeric: For a string of numbers.  
�� Inverse: For light text on a dark background. 
�� Multiple Lines: For a field that can store more than one line of text. When this option is 

selected, a new line is opened in the same field after each line you scan. To continue to 
the next field you will need to press . By default, this option is selected for the Address 
and Notes fields. 

To set the scanning options: 
1. Select Field Settings. 
2. Scroll to the field for which you want to change the settings, then press . 
3. Scroll to each option you want to set. 
4. Press , , or  to toggle the option on or off. A checkmark (�) is displayed when 

the option is on. 
5. Press  to return to the Field Settings menu and save the settings. Repeat steps 2-4 

for each field whose settings you want to change. 
6. The settings are active for all future activities in the Address Book application. 

Note: To temporarily modify the scanning options for a specific field: 
o If the field is highlighted, press   
o If the field is not highlighted, press  to access the Edit Menu and then select 

Scanning Options.  
The Scanning Options menu opens. Whatever you had set will be active for the 
current field only. 
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New File 
Important: 
The full Address Book functionality is only available for the main Address Book file ‘mainadd’, 
therefore, it is not recommended to work with multiple files in this application. The ‘mainadd’ 
file can be the only Address Book file that you need, and it is recommended to work with this 
file only. However, you might want to organize your addresses differently by creating new files 
and storing your addresses in them selectively. 
To create a new file: 
1. Select New File. An Enter file name dialog box opens. 
2. Scan in a file name, or enter one manually. The Pen saves up to eight characters in the 

name. 
Notes: 

o The file name field is initially in Scan mode. If you scan text, the first eight letters 
that you scan are inserted in the file name field, and the OK button is highlighted. 
If you want to rescan the name or edit it manually, press  first to return to the 
file name field.  

o To manually enter the file name, press  once. The file name field will then be 
in Edit mode. Now you can press  again to access the Character Bar (see The 
Character Bar on page 73), or scan the Opticard key of the Opticard to activate 
the Opticard (see The Opticard on page 75), or press again to view the file name 
Edit Menu (this menu contains options specifically for editing file names, see The 
File Name Edit Menu on page 72). 

3. Select OK. 
Open File 
If you have created additional Address Book files (using the New File option), select this 
option to open one: 
1. Select Open File. 
2. Select the file you want to open. 
Note: If your Pen contains only the mainadd file, this is the file that opens each time you select 
the Address Book application. If your Pen contains more than one Address Book file, the last 
file you had used opens automatically the next time you enter the Address Book application. 
Delete File 
If you have created additional Address Book files (using the New File option), select this 
option to delete one of these additional files from your Pen. 
Note: You cannot delete the mainadd file from your Pen. 
1. Select Delete File. 
2. Select the file you want to delete. 
3. Select YES when the confirmation appears. 
Note: If you delete the current file from your Pen, you must open an existing file before you 
can add additional addresses to the Address Book. 
Beaming 
The Beaming options allow sending an address entry to an IrOBEX-compliant device like a 
PDA or a Smartphone, or to receive an address from such a device. 
Send Address 
To send an address from the Pen to a PDA: 
1. Make sure the device is ready to receive the address. 
2. Select Beaming. The Beaming submenu opens. 
3. Select Send Address. The list of addresses in the current file appears. 
4. Scroll to the address you want to send and press . The Pen displays a “Sent 

successfully” message if the address was sent, or an error message if the transfer failed. 
Note: To use the Beaming features, you must align the IR ports of the two devices. The 
IR port is located at the rear of the Pen. 

Receive Address 
To receive an address sent from a PDA: 
1. Select Beaming. The Beaming submenu opens. 
2. Select Receive Address. 
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3. Send the address from the device. When the Pen receives the address, it displays the 
message "Received successfully." 
Note: To use the Beaming features, you must align the IR ports of the two devices. The 
IR port is located at the rear of the Pen. 

Send Business Card 
Notes: 
�� This option is available only when ‘mainadd’ is the current file.  
�� You must have already selected an address as your Business Card (see the following 

option Select Business Card). 
To send your Business Card from the Pen to a PDA: 
1. Make sure the mainadd file is the current file. The name of the current Address Book file 

is displayed at the top of the Address Book Main Menu. If mainadd is not the current file, 
select it by doing the following: 

o Select Open File from the Address Book Main Menu. 
o Select the mainadd file from the list of files. The mainadd file is now the current 

Address Book file. 
2. Select Beaming. The Beaming submenu opens. 
3. Make sure the device is ready to receive the address. 
4. Select Send Business Card. The business card is sent.  

Notes: 
o To send your business card, you must have already selected one address as your 

business card (see the following option - Select Business Card). If you have not 
selected a business card you will get the message ‘Business Card not defined.�. 

o To use the Beaming features, you must align the IR ports of the two devices. The 
IR port is located at the rear of the Pen. 

Select Business Card  
Notes: 
�� This option is available only when ‘mainadd’ is the current file. 
�� The address you select must be one already included in the ‘mainadd’ file. 
�� To use the above Send Business Card option you must first select one address as your 

business card. 
To select an address to be your business card so that it will always be ready to send: 
1. Make sure the mainadd file is the current file. The name of the current address book file is 

displayed at the top of the Address Book Main Menu. If ‘mainadd’ is not the current file, 
select it by doing the following: 

o Select Open File from the Address Book Main Menu. 
o Select the mainadd file from the list of address book files on your Pen. The 

mainadd file is now the current file. 
2. Select Beaming. The Beaming submenu opens. 
3. Select the Select Business Card option. The list of addresses in the mainadd file 

appears. 
4. Scroll to the address you want to use as your business card and press  to select it. 
Exit 
Select this option to return to the Pen Main Menu. 
 

The Address Book Edit Menu 
The Edit Menu contains additional options which affect the editing of the current address. 
Note: an additional Edit Menu is available from the Enter file name dialog box with options for 
editing the file name (see The File Name Edit Menu on page 72). 
Accessing the Edit Menu 
When in an open address (see Creating and Opening Addresses on page 38), make sure you 
are in Edit mode (the cursor should be blinking, see How to know which mode the Pen is in on 
page 39) and press  once to access the Address Book Edit Menu. Following is a 
description of the Edit Menu options: 
Resume Editing 
Select this option to close the Edit Menu and return to the address. 



SuperPen 2.65 Operation Manual 

 45

Activate Overwrite Mode/Activate Insert Mode 
This toggle option is a general option relating to the usage of the Character Bar. For 
information on this option, see Insert Mode and Overwrite Mode on page 73 in ‘The Character 
Bar’ section of this manual. 
Insert Line 
Inserts an additional line in the current field after the current line. 
Delete Line 
Deletes the current line from the entry.  
Clear Line 
Erases the contents of the current line and leaves the line blank. 
Scanning Options 
Select the Scanning Options to temporarily change the scanning option for the next time you 
enter text into the current field. To change the overall default, see Field Settings on page 42. 
The following scanning options are available. You can select any or all of these settings. 
�� Numeric: For a string of numbers.  
�� Inverse: For light text on a dark background. 
�� Multiple Lines: To store more than one line of text. When this option is selected, a new 

line is opened in the same field after each line is scanned. To continue to the next field 
you will need to press . 

Press , , or  to toggle an option on or off. A checkmark (�) is displayed when the 
option is on. Press  to close the Scanning Options, save your settings and return to the 
field you were editing. 
 

Exiting the Address Book Application 
To return to the Pen Main Menu, press  from the Address Book Main Menu or select the 
Exit option below. 
 

QuickLink the Address Book 
Important: 
The transferal of stored addresses between the Pen and PC requires Pen-PC 
Communications. Therefore, you must have already run the one time procedure Set Up 
Product on PC from the SuperPen CD-ROM. If you have not yet done this, please refer to Set 
Up Product on PC on page 9 and follow the instructions there. 
To send stored addresses to the PC: 
1. Turn your PC on. 
2. Make sure that your Pen and PC are connected. Note: they should be connected in the 

same manner you had chosen during the Set Up Product on PC procedure of the 
SuperPen CD-ROM. For example, make sure that the USB plug side of the USB cable is 
connected to the USB outlet on your PC (the same one you had used when running the 
Set Up Product on PC procedure), and that the other side of the cable is connected to 
the PC-Link Connector outlet of your Pen. 

3. Start the QuickLink Desktop application and make sure that Pen communications are on 
(see How to know if Pen Communications are on, page 63). 

4. Turn the Pen on. 
5. Long-press  until you reach the Pen Main Menu. 

6. Press  until QuickLink appears on the screen. 

7. Press . The sending begins. Note: When performing QuickLink, all stored files (from 
all QuickLink applications) on your Pen are sent to the PC, according to the QuickLink 
Settings set in the Desktop application (see Setting the QuickLink Settings in the 
Desktop on page 57). 

8. When the process is done, OK the pop up in the QuickLink  Desktop. 
9. Click the Address Book icon in the QuickLink Desktop application. 
10. The list of addresses you had transferred from the Pen - appear on the screen. 
Note: By default, the addresses of the Pen and Desktop application are synchronized. See 
QuickLink Settings for the Address Book application on page 61 for information on changing 
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these settings, or having the addresses sent or synchronized with additional PC applications 
such as MS Outlook. 
 

The Internet Links Application 
In the Internet Links application, you can store web addresses (URLs). 
 

Accessing the Internet Links Application 
1. Long-press  to reach the Pen Main Menu. 
2. Select the Internet Links option. 
3. The Internet Links application starts and its Main Menu appears. 
 

Creating and Opening Links 
To create a new link: 
1. From the Internet Links Main Menu, select New Link. 
2. A new link is created and opened for editing. 
To open an existing link: 
1. From the Internet Links Main Menu, select View Links. 
2. Scroll and highlight the link you wish to open for editing. 
3. Press . 
4. Select Edit Link. 
5. The link is opened, displaying its existing text. You can now edit the link. 
 

Editing Links 
 

Easy Steps 
1. Create or open a link (see above). The Internet Link field appears and the file is in Scan 

mode (see Scan Mode on page 46) – meaning you can simply start scanning and the 
fields will accept the scanned text. 

2. Scan in the web address you want to store (for example, from a business card). The Pen 
is set for scanning English text. Note: if you want to scan text that is in a different 
language, see Next Link Language on page 49. If you want to scan numeric or inverse 
text, or if you want a field to contain more than one line, see Scanning Options on page 
50. 

3. The web address (URL) you have scanned is placed in the Internet Link field 
(highlighted), and the Pen automatically advances to the next field which is Description 
(see on Auto Advance on page 49). 

4. If the scanning results on the screen are not satisfactory (see Poor Character Recognition 
on page 13), you can edit the cell in various ways - see Editing Existing Text on page 46. 

5. When you have finished filling the fields, either select the OK button at the bottom of the 
entry, or press  (once – if in Scan mode, three times if in Edit mode).  

6. The information you have just scanned is saved to your Pen as one new link entry. The 
Internet Links Main Menu is displayed. 
Note: If the information you have scanned exceeds the width of the Pen display, you can 
see the entire entry by viewing the link (see View Link on page 48). 

 

Editing Existing Text 
There are 2 modes for editing existing text – Scan mode and Edit Mode. The mode affects the 
editing of the current field, meaning you must currently be in an open field. 
Scan Mode 
This is the default mode in the Internet Links application. When the current field is in Scan 
mode, scanning new text will delete any text from the whole field (if existing) and replace it 
with the new text you have scanned. This is useful for rescanning the whole field. 
Edit Mode 
When the current field is in Edit mode, you can do any following: 
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�� Insert Text: Scan new text you want to insert into the current field. Please scan whole 
words and not single characters (for single character editing use the Character Bar or the 
Opticard). The new text is inserted where the cursor was positioned and spaces are 
added to create correct word separation within the line of text. To quickly undo this new 
scan, simply press . This will delete the new scan which initially appeared highlighted 
(it is highlighted to allow this quick undoing). If you do not want to undo the new scan, 
press the arrow buttons to de-highlight the text, before entering more text. 

�� Use the Edit Menu: press  to access the Internet Links Edit Menu (see The Internet 
Links Edit Menu on page 50). 

�� Use the Character Bar: Press  to display the Character Bar (see The Character Bar 
on page 73) and edit the point at which the cursor is inserted. 

�� Use the Opticard: Scan the Opticard key to activate the Opticard (see The Opticard on 
page 75) and edit the point at which the cursor is inserted. 

How to know which mode the Pen is in 
�� In Scan mode the whole field appears with a black background and all the text is green. 

There is no blinking cursor.  
�� In Edit mode there is a blinking cursor in the current field.  
Switching between Scan mode and Edit mode 
�� If you are in Scan mode (no blinking cursor, field background is black), press  to 

switch to Edit mode. 
�� If you are in Edit mode (blinking cursor), press  twice to switch to Scan mode. 
 

Navigation Shortcuts 
Double-clicking the arrow buttons quickly moves the cursor within the current field of an link 
entry (when the cursor is blinking in Edit mode). 

Double-click 
this button 

To move the cursor to:  

 
The beginning of the field 

 
The end of the field 

 
 

Scanning in Different Languages 
Please refer to Next Link Language on page 49. 
 

Closing and Saving Links 
When editing a link, scroll to the OK button and press  to close the link. Its contents are 
saved and the Internet Links Main Menu appears. 
You may also press  in which case the Save changes? message will appear (note that if 
you were in Edit mode - the Edit Menu will appear. Press .to close it and press  again 
to reach the Save changes? message): 
�� If you chose YES, the link closes, its contents are saved and the Internet Links Main 

Menu appears. 
�� If you chose NO, the link closes, its contents are not saved and the Internet Links Main 

Menu appears. 
�� If you chose CANCEL, you are brought back to the field you were editing. 
 

Viewing Links 
Please refer to View Links on page 48 and View Link on page 48. 
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The Internet Links Menu Options 
 

The Internet Links Main Menu 
Accessing the Main Menu 
To access the main menu of the application, select Internet Links from the Pen Main Menu. 
When already in the menu options of the Internet Links, press  to return to the Internet 
Links Main Menu. When editing a link entry, see Closing and Saving Links on page 47 for 
instructions on returning to the main menu. 
Following is a description of the Internet Links Main Menu options: 
Main Menu Caption – Current File 
The caption of the Internet Links Main Menu displays the name of the main internet links file 
‘File: mainlnk’. This is the current file. 
New Link 
Select this option to scan in a new Internet Link entry.  
1. Select New Link. 
2. A new link is created and the first field appears in Scan mode. 
3. The link is ready for editing. See Editing Links on page 46 for information on editing links. 
View Links 
Select this option to view the Internet Link entries that are on your Pen: 
� Select View Links. A list appears consisting of all links in the current Internet Link file. 
The Links Menu 
When in the View Links, list it is possible to access the Links Menu which contains options 
for deleting, viewing, and editing specific links from the list. 
Accessing the Links Menu 
1. From the Internet Links Main Menu select View Links. 
2. Scroll to the link you wish to delete, view or edit (until it is highlighted) 
3. Press  to open the menu. 
The following options are available in the Links Menu: 
Delete Link 
Select this option to delete the current link. 
1. In the View Links list scroll to the link you want to delete (until it is highlighted). 
2. Select Delete Link. 
3. When the confirmation appears, select YES. 
View Link 
Select this option to view the current link. 
1. In the View Links list scroll to the link you want to view (until it is highlighted). 
2. Press  or press  to access the Links Menu and then select View Link. 
3. The link is displayed in View mode, i.e., you can scroll through the link fields, but you 

cannot make any changes. 
Edit Link 
Select this option to edit the current link. 
1. In the View Links list scroll to the link you want to edit (until it is highlighted). 
2. Press  twice or press  to access the Links Menu and then select Edit Link. 
3. The link opens and the first field appears in Scan mode. 
4. The link is ready for editing. See Editing Links on page 46 for information on editing links. 
Settings 
The Settings submenu contains scanning and display options for link entries. 
Accessing the Settings Menu 
�� From the Internet Links Main Menu select Settings. 
You can change more than one setting at a time. Once you have changed the settings, press 

 to return to the Internet Links Main Menu. 
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The Settings menu contains the following options: 
Scroll Screen 
When Scroll Screen is selected, the display scrolls, rather than jumps, to the following field 
each time you finish scanning a line. This is the default.  
To toggle Scroll Screen on or off, press , , or . A checkmark (�) is displayed when it 
is on. 
Auto Advance 
When Auto Advance is selected, the display moves automatically to the next field when you 
finish scanning a line. This is the default. When Auto Advance is not selected, you must scroll 
manually from field to field after scanning in information by pressing .  
To toggle Auto Advance on or off, press , , or . A checkmark (�) is displayed when 
it is on. 
AutoDescribe 
Select AutoDescribe, so that after scanning the Internet Link field in a link entry, the 
Description field is automatically filled with the middle portion of the link – which is usually the 
company name. 
To toggle AutoDescribe on or off, press , , or . A checkmark (�) is displayed when 
it is on. 
Next Link Language 
Note: The Next Link Language option appears only if scanning languages have been added 
to the Pen (see Adding Spellers on page 71). If none have been added, the Pen is preset for 
scanning English text. 
Use this option to change the scanning language in the Internet Links - if the material you are 
about to scan is in a different language than the current setting. When the Next Link 
Language setting matches the language of the printed text, the scanning results are optimal 
since a spelling check for that specific language is performed. 
Important: 
This setting affects the scanning language of all future scanning into the Internet Link 
application. If you wish to change the general setting of the Pen, which will affect all new files 
created on the Pen, in all of the applications, then please change the scanning language in the 
Set Scanning Language option in the Settings menu of the Pen Main Menu (See Scanning 
Language on page 66). 
To change the language prior to creating the new link: 
5. Select Next Link Language. 
6. Select the language you want. 
New File 
Important: 
The full Internet Links functionality is only available for the main Internet Links file ‘mainlnk’, 
therefore, it is not recommended to work with multiple files in this application. The ‘mainlnk’ file 
can be the only Internet Links file that you need, and it is recommended to work with this file 
only. However, you might want to organize your links differently by creating new files and 
storing your links in them selectively. 
To create a new file: 
1. Select New File. An Enter file name dialog box opens. 
2. Scan in a file name, or enter one manually. The Pen saves up to eight characters in the 

name. 
Notes: 

o The file name field is initially in Scan mode. If you scan text, the first eight letters 
that you scan are inserted in the file name field, and the OK button is highlighted. 
If you want to rescan the name or edit it manually, press  first to return to the 
file name field.  

o To manually enter the file name, press  once. The file name field will then be 
in Edit mode. Now you can press  again to access the Character Bar (see The 
Character Bar on page 73), or scan the Opticard key of the Opticard to activate 
the Opticard (see The Opticard on page 75), or press again to view the file name 
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Edit Menu (this menu contains options specifically for editing file names, see The 
File Name Edit Menu on page 72). 

3. Select OK. 
Open File 
If you have created additional Internet Links files (using the New File option), select this option 
to open one: 
1. Select Open File. 
2. Select the file you want to open. 
Note: If your Pen contains only the mainlnk file, this is the file that opens each time you select 
the Internet Links application. If your Pen contains more than one Internet Links file, the last 
file you had used opens automatically the next time you enter the Internet Links application. 
Delete File 
If you have created additional Internet Links files (using the New File option), then select this 
option to delete one of these additional files from your Pen. 
Note: You cannot delete the mainlnk file from your Pen. 
1. Select Delete File. 
2. Select the file you want to delete. 
3. Select YES when the confirmation appears. 
Note: If you delete the current file from your Pen, you must open an existing file before you 
can add additional links to the Internet Links. 
Exit 
Select this option to return to the Pen Main Menu. 
 

The Internet Links Edit Menu 
The Edit Menu contains additional options which affect the editing of the current link. 
Note: an additional Edit Menu is available from the Enter file name dialog box with options for 
editing the file name (see The File Name Edit Menu on page 72). 
Accessing the Edit Menu 
When in an open link (see Creating and Opening Links on page 46), make sure you are in Edit 
mode (the cursor should be blinking, see How to know which mode the Pen is in on page 47) 
and press  once to access the Internet Links Edit Menu. Following is a description of the 
Edit Menu options: 
Resume Editing 
Select this option to close the Edit Menu and return to the link. 
Activate Overwrite Mode/Activate Insert Mode 
This toggle option is a general option relating to the usage of the Character Bar. For 
information on this option, see Insert Mode and Overwrite Mode on page 73 in ‘The Character 
Bar’ section of this manual. 
Insert Line 
Inserts an additional line in the current field after the current line. 
Delete Line 
Deletes the current line from the entry.  
Clear Line 
Erases the contents of the current line and leaves the line blank. 
Scanning Options 
Select the Scanning Options to temporarily change the scanning option for the next time you 
enter text into the current field. 
The following scanning options are available. You can select any or all of these settings. 
�� Numeric: For a string of numbers.  
�� Inverse: For light text on a dark background. 
�� Multiple Lines: To store more than one line of text. When this option is selected, a new 

line is opened in the same field after each line is scanned. To continue to the next field 
you will need to press . 

Press , , or  to toggle an option on or off. A checkmark (�) is displayed when the 
option is on. Press  to close the Scanning Options, save your settings and return to the 
field you were editing. 
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Exiting the Internet Links Application 
To return to the Pen Main Menu, press  from the Internet Links Main Menu or select the 
Exit option below. 
 

QuickLink the Internet Links 
Important: 
The transferal of stored links between the Pen and PC requires Pen-PC Communications. 
Therefore, you must have already run the one time procedure Set Up Product on PC from 
the SuperPen CD-ROM. If you have not yet done this, please refer to Set Up Product on PC 
on page 9 and follow the instructions there. 
To send stored links to the PC: 
1. Turn your PC on. 
2. Make sure that your Pen and PC are connected. Note: they should be connected in the 

same manner you had chosen during the Set Up Product on PC procedure of the 
SuperPen CD-ROM. For example, make sure that the USB plug side of the USB cable is 
connected to the USB outlet on your PC (the same one you had used when running the 
Set Up Product on PC procedure), and that the other side of the cable is connected to 
the PC-Link Connector outlet of your Pen. 

3. Start the QuickLink Desktop application and make sure that Pen communications are on 
(see How to know if Pen Communications are on, page 63). 

4. Turn the Pen on. 
5. Long-press  until you reach the Pen Main Menu. 

6. Press  until QuickLink appears on the screen. 

7. Press . The sending begins. Note: When performing QuickLink, all stored files (from 
all QuickLink applications) on your Pen are sent to the PC, according to the QuickLink 
Settings set in the Desktop application (see Setting the QuickLink Settings in the 
Desktop on page 57). 

8. When the process is done, OK the pop up in the QuickLink Desktop. 
9. Click the Internet Links icon in the QuickLink Desktop application. 
10. The list of links you had transferred from the Pen - appear on the screen. 
Note: By default, the links of the Pen and Desktop application are synchronized. See 
QuickLink Settings for the Internet Links application on page 61 for information on 
changing these settings, or having the links sent to or synchronized with additional PC 
applications such as MS Internet Explorer. 
 
 

The Tables Application 
The Tables application is used to scan and store tables and charts. 
 

Accessing the Tables Application 
1. Long-press  until you reach the Pen Main Menu. 
2. Select the Tables option. 
3. The Tables application starts and its main menu appears. 
 

Creating and Opening Tables 
From the Tables Main Menu, select any of the following options: 
�� Select Edit Current File to open the current file. The ‘current’ file is the one whose name 

appears in the caption of this menu. If no file is currently open, the message No Open 
File appears in the caption. In this case, selecting Edit Current File will first show the 
message No Open File and then show the Enter file name dialog box, suggesting a new 
file name. 

�� Select New File to create a new file and then open it. The Enter file name screen will first 
appear suggesting a default file name. 
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�� Select Open File to select an existing file and open it. A list will first appear suggesting all 
available files. 

The file opens and the blinking cursor indicates the point at which text will be inserted. 
 

Editing Tables 
 

Easy Steps 
1. Create or open a file (see above). The tables cells appear in Scan mode (see How to 

know which mode the Pen is in on page 52) – meaning you can simply start scanning and 
the cell will accept the scanned text. Each table cell has a caption with a letter (starting 
with A and continuing with B, C, D, etc.), indicating the column in which the current cell is 
positioned and a number (starting with 1 and continuing with 2, 3, 4, etc.) indicating its 
row. 

2. Make sure the Pen screen displays the required cell; if not, scroll until it does. Then scan 
in the parallel cell from an English printout of a table, for example, if you wish to scan in 
the first cell of a table (top left cell), the Pen should display the A1 cell on its screen. Note: 
if you want to scan text that is in a different language, see Select Language on page 55. 
If you want to scan numeric or inverse text, or if you want a cell to contain more than one 
line, see  

3. Scanning Options on page 55. 
4. The new text appears in the cell and the new text is highlighted. 
5. If the scanning results on the screen are not satisfactory (see Poor Character Recognition 

on page 13), you can edit the cell in various ways - see Editing Existing Text on page 52. 
6. Scroll to the next cell (scrolling to the right will proceed to the next cell in the same row, 

scrolling down will scroll to the next cell in the same column). 
7. Continue scanning the table cells. 
8. When done, press  (once if in Scan mode, 3 times if in Edit mode) to close the file and 

save your changes. The Tables Main Menu is displayed. 
 

Editing Existing Text 
There are 2 modes for editing existing text – Scan mode and Edit Mode. The mode affects the 
editing of the current field (cell) - meaning you must currently be in an open field. 
Scan Mode 
This is the default mode in the Tables application. When the current field is in Scan mode, 
scanning new text will delete any text from the whole field (if existing) and replace it with the 
new text you have scanned. This is useful for rescanning the whole field. 
Edit Mode 
When the current field is in Edit mode, you can do any following: 
�� Insert Text: scan new text you want to insert into the current field. Please scan whole 

words and not single characters (for single character editing, use the Character Bar or the 
Opticard). The new text is inserted where the cursor was positioned and spaces are 
added to create correct word separation within the line of text. To quickly undo this new 
scan, simply press . This will delete the new scan which initially appeared highlighted 
(it appeared highlighted to allow this quick undoing). If you do not want to undo the new 
scan, press the arrow buttons to de-highlight the text, before entering more text. 

�� Use the Edit Menu: press  to access the Tables Edit Menu (see The Tables Edit 
Menu on page 54). 

�� Use the Character Bar: press  to display the Character Bar (see The Character Bar 
on page 73) and edit the point at which the cursor is inserted. 

�� Use the Opticard: scan the Opticard key to activate the Opticard (see The Opticard on 
page 75) and edit the point at which the cursor is inserted. 

How to know which mode the Pen is in 
�� In Scan mode the whole field appears with a black background and all the text is green. 

There is no blinking cursor.  
�� In Edit mode there is a blinking cursor in the current field.  
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Switching between Scan mode and Edit mode 
o If you are in Scan mode (no blinking cursor, field background is black), press  to 

switch to Edit mode. 
o If you are in Edit mode (blinking cursor), press  twice to switch to Scan mode. 
 

Navigation Shortcuts 
Double-clicking the arrow buttons on the Pen quickly moves the cursor within the current cell 
(when the cursor is blinking - in Edit mode).  

Double-click 
this button 

To move the cursor to:  

 
The beginning of the cell 

 
The end of the cell 

Scanning in different Languages 
Please refer to Select Language on page 55. 
 

Closing and Saving Table Files 
When done editing a file, press  (once if in Scan mode, 3 times if in Edit mode) to close 
the table file and save your changes. The Tables Main Menu is displayed. 
 

The Tables Menu Options 
 

The Tables Main Menu 
The Main Menu contains the high level options of the Tables application. 
Accessing the Main Menu 
To access the main menu of the application, select Tables from the Pen Main Menu. When 
already in the Tables application press  to reach the Tables Main Menu. 
Following is a description of the Main Menu options: 
Main Menu Caption – Current File 
The caption of the Tables Main Menu displays the current file. If no file is open, the caption 
displays “No Open File”. 
 
Edit Current File 
To edit the current table file: 
1. Select Edit Current File. The ‘current’ file is the last file you worked on, whose name is 

displayed in the caption of the Tables Main Menu. 
2. The file is opened and the cell you edited last appears in Scan mode. 
3. The file is now ready for editing. See Editing Tables on page 52 for information on editing 

tables. 
Settings 
The Settings submenu contains scanning and display options for tables. 
Accessing the Settings Menu 
�� From the Tables Main Menu select Settings. 
You can change more than one setting at a time. Once you have changed the settings, press 

 to return to the Tables Main Menu. 
The Settings menu contains the following options: 
Scroll Screen 
When Scroll Screen is selected, the display scrolls, rather than jumps, to the following field 
each time you finish scanning a line. This is the default.  
To toggle Scroll Screen on or off, press , , or . A checkmark (�) is displayed when it 
is on. 
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Auto Advance 
When Auto Advance is selected, the display moves automatically to the next cell on the right, 
when you finish scanning a cell. When Auto Advance is not selected, you must scroll 
manually from cell to cell after scanning in information by pressing the arrow buttons  
To toggle Auto Advance on or off, press , , or . A checkmark (�) is displayed when 
it is on. 
Right-to-Left Table 
Select Right-to-Left Table to change the direction of the table so that the first cell is in the 
upper right corner of the table and the table scrolls from right to left.  
To toggle the Right-to-Left Table option on or off, press , , or . A checkmark (�) is 
displayed when it is on. 
New File 
To create a new table file: 
1. Select New File. The Enter file name dialog box opens in Scan mode (the field is 

highlighted). 
2. Scan in a file name, or enter one manually. The Pen saves up to eight characters in the 

name. 
Notes: 

o The file name field is initially in Scan mode. If you scan text, the first eight letters 
that you scan are inserted in the file name field, and the OK button is highlighted. 
If you want to rescan the name or edit it manually, press  first to return to the 
file name field.  

o To manually enter the file name, press  once. The file name field will then be 
in Edit mode. Now you can press  again to access the Character Bar (see The 
Character Bar on page 73), or scan the Opticard key of the Opticard to activate 
the Opticard (see The Opticard on page 75), or press again to view the file name 
Edit Menu (this menu contains options specifically for editing file names, see The 
File Name Edit Menu on page 72). 

3. Select OK. 
4. A new file is created and the first cell appears in Scan mode. 
5. The file is now ready for editing. See Editing Tables on page 52 for information on editing 

tables. 
Open File 
To open an existing table file: 
1. Select Open File. A list of existing files appears. 
2. Select the file you want to open. 
3. The file is opened and the first cell appears in Scan mode. 
4. The file is now ready for editing. See Editing Tables on page 52 for information on editing 

tables. 
Delete File 
To delete an existing table file: 
1. Select Delete File. 
2. Select the file you want to delete. 
3. Select YES when the confirmation message appears. 
Exit 
Exits the Tables application and returns to the Pen Main Menu. 
 

The Tables Edit Menu 
The Edit Menu contains additional options which affect the editing of the current open file. 
Note: an additional Edit Menu is available from the Enter file name dialog box with options for 
editing the file name (see The File Name Edit Menu on page 72). 
Accessing the Edit Menu 
When in an open table (see Creating and Opening Tables on page 51), make sure you are in 
Edit mode (the cursor should be blinking, see Edit Mode on page 52) and press  once to 
access the Tables Edit Menu. Following is a description of the Edit Menu options: 
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Resume Editing 
Select this option to close the Edit Menu and return to the table. 
Activate Overwrite Mode/Activate Insert Mode 
This toggle option is a general option relating to the usage of the Character Bar. For 
information on this option, see Insert Mode and Overwrite Mode on page 73 in ‘The Character 
Bar’ section of this manual. 
Clear Line 
Select this option to erase the current line in the current cell. 
Select Language 
Note: The Select Language option appears only if scanning languages have been added to 
the Pen (see Adding Spellers on page 71). If none have been added, the Pen is preset for 
scanning English text. 
Use this option to change the scanning language if the material you are scanning is in a 
different language. When the Scanning Language setting matches the language of the 
printed text, the scanning results are optimal, since a spelling check for that specific language 
is performed. 
Important: 
This setting affects the future scanning into the current file only. This may be useful when 
scanning different languages into one file. If you wish to change the general setting of the Pen, 
which will affect all new files created on the Pen- in all of the applications, then please change 
the scanning language in the Set Scanning Language option in the Settings menu of the 
Pen Main Menu (see Scanning Language on page 66). 
To select a scanning language: 
1. Access a new cell. Note: You cannot change the scanning language if text already exists 

in the current cell. Open a new cell before you change the scanning language. Otherwise, 
the Pen will ask you to delete the existing text. 

2. If the cell is in Scan mode (if the cell appears with a black background) press �to 
activate the Edit mode.  

3. When in Edit mode, press  to open the Edit Menu. 
4. Select the Select Language option. The current language appears highlighted. 
5. Select the language you want. 
6. This setting affects future scanning into the current file only. Any new file created will be 

set to the scanning language that is set in the Set Scanning Language option in the 
Settings menu of the Pen Main Menu. 

 
Scanning Options 
Select the Scanning Options to temporarily change the scanning option for the next time you 
enter text into the current field. 
The following scanning options are available. You can select any or all of these settings. 
�� Numeric: For a string of numbers.  
�� Inverse: For light text on a dark background. 
�� Multiple Lines: To store more than one line of text. When this option is selected, a new 

line is opened in the same field after each line is scanned. To continue to the next field 
you will need to press . 

Press , , or  to toggle an option on or off. A checkmark (�) is displayed when the 
option is on. Press  to close the Scanning Options, save your settings and return to the 
table you were editing. 
Insert Row 
Select this option to add a row to the open table file. The row is inserted above the current 
row. 
Insert Column 
Select this option to add a column to the open table file. The column is inserted before the 
current column. 
Remove Row 
Select this option to remove the current row from the open table file. 
Remove Column 
Select this option to remove the current column from the open table file. 
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Insert Line 
Select this option to insert an additional line in the current cell, after the current line. 
Note: If the Multiple Lines Scanning Option is activated for this cell, you just need to scroll 
to the last line in the cell and press  in order to add a line. 
Delete Line 
Select this option to delete the current line from the cell. 
 

Exiting the Tables Application 
To return to the Pen Main Menu, press  from the Tables Main Menu or select the Exit 
option at the bottom of it. 
 

QuickLink the Tables 
Important: 
The transferal of stored file info between the Pen and PC requires Pen-PC Communications. 
Therefore, you must have already run the one time procedure Set Up Product on PC from 
the SuperPen CD-ROM. If you have not yet done this, please refer to Set Up Product on PC 
on page 9 and follow the instructions there. 
To send stored tables to the PC: 
1. Turn your PC on. 
2. Make sure that your Pen and PC are connected. Note: they should be connected in the 

same manner you had chosen during the Set Up Product on PC procedure of the 
SuperPen CD-ROM. For example, make sure that the USB plug side of the USB cable is 
connected to the USB outlet on your PC (the same one you had used when running the 
Set Up Product on PC procedure) and that the other side of the cable is connected to the 
PC-Link Connector outlet of your Pen. 

3. Start the QuickLink Desktop application and make sure that Pen communications are on 
(see How to know if Pen Communications are on, page 63). 

4. Turn the Pen on. 
5. Long-press  until you reach the Pen Main Menu. 

6. Press  until QuickLink appears on the screen. 

7. Press . The sending begins. Note: When performing QuickLink, all stored files (from 
all QuickLink applications) on your Pen are sent to the PC, according to the QuickLink 
Settings set in the Desktop application (see Setting the QuickLink Settings in the 
Desktop on page 57). 

8. When the process is done, OK the pop up in the QuickLink Desktop. 
9. Click the Tables icon in the QuickLink Desktop application. 
10. The list of tables you had transferred from the Pen - appear on the screen. 
Note: By default, the stored files of the Tables application are copied from the Pen to the 
Desktop application and then deleted from the Pen. See QuickLink Settings for the Tables 
application on page 62 for information on changing these settings or having the files sent to 
additional PC applications such as MS Explorer. 
 
 

The QuickLink Function 
The transfer of stored data is possible between the Pen and the PC (Desktop and Host 
applications), using the QuickLink option on the Pen. The send process is performed for files 
of any QuickLink applications on the Pen. The QuickLink is performed according to the 
settings set in the QuickLink Settings dialog in the Desktop application. The QuickLink is 
initiated by the Pen – while the PC is prepared to receive this initiation. 
 
Following are instructions for setting and performing the QuickLink operation. 
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Preparing the PC 
Important: 
Transfer of stored file info between the Pen and PC requires Pen-PC Communications. 
Therefore, you must have already run the one time procedure Set Up Product on PC from 
the SuperPen CD-ROM. If you have not yet done this, please refer to Set Up Product on PC 
on page 9, and follow the instructions there. 
Starting the Desktop Application 
1. Turn your PC on. 

Important: Close any applications that are running on your computer. The icons of the 
applications that are running on your PC appear in the System Tray. It is especially 
important to close applications that use the serial or USB ports of your computer, such as 
PDAs or digital camera applications. 

2. Start the QuickLink Desktop application: 
o If, during installation, you chose to add the Desktop to your computer’s startup, 

the Desktop will automatically start running when you start your computer, its 
window minimized. To reveal the Desktop window, click the Desktop icon ( ) in 
the system tray at the bottom of the screen. If the Desktop window does not 
appear, select the Show Window option from the pop-up menu. 

o If the Desktop application does not run when you start up your computer, or if you 
closed the application, you can start it by opening the Windows Start menu and 
select Programs\QuickLink Desktop\QuickLink Desktop.  

3. For more information on the Desktop application, you can refer to its Help file (click on the 
Windows Start menu and select Programs\QuickLink Desktop\QuickLink Desktop 
Help). 

Setting the QuickLink Settings in the Desktop 
The QuickLink Settings in the Desktop are already preset to a default. If the following default 
settings suit your needs – you need not perform any of the procedures in this section, and you 
can continue to the next section - Confirming Pen-PC Communications on page 63. 
The QuickLink operation is performed according to the settings set in the QuickLink 
Settings dialog (and its child dialog Host Settings). 
 
The Default QuickLink Settings 
Following are the default settings for each of the QuickLink applications: 

Notes: The stored note files of the Notes application are copied from the Pen to the 
Desktop application and then deleted from the Pen (“flushed”). 
Address Book: The stored addresses in the mainadd files on the Pen and Desktop 
are synchronized, resulting in identical data on Pen and Desktop. The addresses are 
not deleted from the Pen. 
Internet Links: The stored links in the mainlnk files on the Pen and Desktop are 
synchronized, resulting in identical data on Pen and Desktop. The links are not 
deleted from the Pen. 
Tables: The stored table files of the Tables application are copied from the Pen to the 
Desktop application and then deleted from the Pen (“flushed”). 
Image Capture: The stored image files of the Image Capture application are copied 
from the Pen to the Desktop application and then deleted from the Pen (“flushed”). 
Note that the Image Capture is an add-on application which you may not have 
included in your product. If you wish to include it, see Adding the Image Capture on 
page 76. 

Note: By default, QuickLink is performed without host applications.  
 
If you wish to change any of these default settings – see the following instructions. 
 
Accessing the QuickLink Settings Dialog 
In the Desktop application select Pen Communications from the menu bar, and then select 
the QuickLink Settings… option. The QuickLink Settings dialog opens, displaying the 
current QuickLink Settings for each of the applications installed in the Desktop. 
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The QuickLink Settings Dialog 
The Application Settings 
The QuickLink Settings dialog displays each QuickLink application installed in your product 
and its current QuickLink Settings. This information is displayed in the middle area of the 
dialog in a 4 column table. Following is a description of each column: 
Application 
Each row displays a different QuickLink application which you have installed on your Pen and 
PC. 
Mode 
This is what will be done with the application files on the Pen and PC - when performing the 
QuickLink operation. 
Flush 
When on, this column says Yes and the application files are deleted from the Pen at the end 
of the QuickLink operation.  
When off – this column says No and the application files on the Pen are not deleted. 
Host Application 
If a host application is set – its name will appear here, if none is set – None will appear.  
A host application is a PC application – other than the QuickLink Desktop application – to 
which the stored files can also be transferred to. This way you can view the sent stored data in 
these applications, in addition to viewing it in the Desktop application. See Activating Host 
Settings on page 59 for information on activating the possibility of involving Host Applications 
in the send process, since by default this feature is turned off. 
Pen Name 
The name of the current Pen Name (the one whose data is currently displayed in the Desktop) 
- is displayed in the Desktop bar. The QuickLink Settings dialog displays the setting for one 
“Pen Name”. When launching the QuickLink Settings dialog – the settings of the current Pen 
Name are displayed, and its name appears again in the top left of the QuickLink Settings 
dialog. 
The Pen Name is a profile used in the Desktop for storing the data of one scanning device. 
When performing Pen-PC communications, such as QuickLink, the Desktop matches the 
scanning device with its associated Pen Name so that the data of one Pen is always stored in 
the associated Pen Name profile.  

Important: The Pen Name mechanism is for advanced users 
only, or users that own more than one actual scanning device. 

 
If you have one scanning device - it is highly advised to work 

with the default Pen Name “MyPen” – only. 
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Activating Host Settings 
If you want the Pen to perform the QuickLink with host applications, click the This Pen Name 
will QuickLink with host applications checkbox. Default host settings are set for each 
application, and the Host Settings button is activated allowing access to the Host Settings 
dialog. 
Note: Only one Pen Name can be designated at a time to interact with host applications. 
Again, as expressed before, it is advised to work with the default Pen Name “MyPen”.  
The Default Host Settings 
By default, QuickLink is performed without host applications. If you have set for a Pen Name 
to QuickLink with host applications, as described above, then the following default host 
settings are set for any QuickLink performed (with the Pen associated with the set Pen 
Name): 
o Microsoft Word as the host for Notes. Word files (*.doc) are placed in My 

Documents\QuickLink\Notes folder. 
o Microsoft Outlook as the host for Address Book. The Contacts from Outlook and the 

addresses from the SuperPen Pen and Desktop are synchronized. 
o Microsoft Internet Explorer as the host for Internet Links. The links in your 

Favorites\QuickLink folder in Internet Explorer and the links from SuperPen Pen and 
Desktop are synchronized. 

o Microsoft Excel as the host for Tables. Excel files (*.xls) are placed in My 
Documents\QuickLink\Tables folder. 

o Note: there is no host application for the Image Capture application. 
Important: Any host applications you have set must be fully 
installed and functional on your PC, or else the QuickLink 

function will fail. 
If you want to cancel interaction of this product with host 

applications, simply uncheck This Pen Name will QuickLink 
with host applications checkbox. 

If you want to turn off the host interaction for some of the 
QuickLink applications – but leave it on for others, see about 

the  Host Application column of the Host Settings dialog, 
page 60. 

 
The Host Settings Dialog 
To change the host settings you have set, select the Host Settings button on the QuickLink 
Settings dialog - to display the Host Settings child dialog. 
Note: if the Host Settings button is inactive, see Activating Host Settings on page 59 for 
information on activating it.  

 
The dialog box displays a 4 column table in which the QuickLink applications on your Pen and 
their host settings are listed.  
 
Following is a description of each column: 
Application 
Each row displays a different QuickLink application which you have installed on your Pen and 
PC (this should be the same list viewed in the QuickLink Settings father dialog). 
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Pen File 
The file(s) from each QuickLink application that can be transferred to or from the host 
application, when performing the QuickLink operation: 

Notes: All Notes files (*.qnt). 
Address Book: The addresses from the main Address Book file (mainadd.qad).  
Internet Links: The links from the main Internet Links file (mainlnk.qlk). 
Tables: All Tables files (*.qtb). 

Host Application 
The current host application set for the application. This option contains a list of available 
hosts for each application, plus the option None. Use the None option to turn off host 
application interaction for a specific application. 
Host Folder 
The folder in which the host application files, that are created or updated during the 
QuickLink process, are stored. 
Note: Files sent, with a host application set, are placed in the folder specified in the Host 
Folder column, as well as in the PenData\pen name\application folder under the QuickLink 
Desktop installation folder. 
Show this dialog before each QuickLink 
At the bottom of the QuickLink Settings dialog is a Show this dialog before each 
QuickLink check box. Checked is on, not checked is off (the default). Click the option to 
toggle the check mark. When this option is on, this dialog will appear right after selecting the 
QuickLink on the Pen, prior to actually starting the process. This way you can confirm that the 
settings are satisfactory. If they are not satisfactory – you can change them. When done, 
press QuickLink from the QuickLink Settings Dialog - to continue the send process, or 
press Close - to stop the process. 
 
QuickLink Settings for the Notes application 
Changing the Mode or Flush Settings 
1. Access the QuickLink Settings dialog. 
2. Select Notes row from the table. 
3. Click the Change button. 
4. The Change QuickLink Settings dialog appears. 
5. From the QuickLink Mode section, click on the desired mode to activate its radio button: 

o Pen to PC (the default) will set that the stored text files from your Pen will be 
copied from the Pen to the PC. 

o Don’t QuickLink the files of this application – when selecting this option, the 
QuickLink does not include the Notes application, or its files, and no changes are 
performed - not on the Pen nor in the PC (Desktop or Host Applications). 

6. In the right side of the Change QuickLink Settings dialog, click on the Flush check box 
to set the Flush mode. Checked is on (the default), not checked is off. When on – this 
option will cause the Notes files on the Pen to be deleted after they are sent to the PC 
when performing QuickLink. 

Changing the Host Application Settings 
1. Make sure that the This Pen Name will QuickLink with host applications check box on 

the QuickLink Settings dialog is on, and click the Host Settings button. Note: if the Host 
Settings button is inactive, see Activating Host Settings on page 59 for information on 
activating it.   

2. The Host Settings dialog appears. 
3. Select Notes row from the table. 
4. Click the application name field (under the Host Application column). 
5. Chose the desired setting from the list that opens: 

o Word – the stored pen files of this application are converted to .doc format and 
placed in the folder specified in the Host Folder column. You can access this 
folder with MS Explorer and double-click any of the files. The files will open in MS 
Word (if installed on your PC). 

o Outlook– the stored pen files of this application are converted to the Outlook 
Notes format and placed in the MS Outlook Notes folder, as specified in the Host 
Folder column. 

o None – select this option to cancel any host interaction with the Notes application. 
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6. Click OK to save changes and close the Host Settings dialog. Click Cancel to disregard 
any settings you have just changed. 

QuickLink Settings for the Address Book application 
Changing the Mode or Flush Settings 
1. Access the QuickLink Settings dialog. 
2. Select the Address Book row from the table. 
3. Click on the Change button. 
4. The Change QuickLink Settings dialog appears. 
5. From the QuickLink Mode section, click on the desired mode to activate its radio button: 

o Synchronize Pen and PC (the default) - all addresses from the main Address 
Book (mainadd) – those stored in the Pen and those created or modified in the 
PC (Desktop and Host Application) - are synchronized - resulting in one Address 
Book file (mainadd), identical on the Pen, on the Desktop, and in the Host 
application (if one is set). 

o PC to Pen will result in the address book files, existing in the Address Book 
application of the Desktop, being copied to the Pen (overwriting the ones on the 
Pen). 

o Don’t QuickLink the files of this application – when selecting this option, the 
QuickLink does not include the Address Book application, or its files, and no 
changes are performed - not on the Pen, nor in the PC (Desktop or Host 
Applications). 

6. In the right side of the Change QuickLink Settings dialog, click on the Flush check box 
to set the Flush mode. Checked is on, not checked is off (the default). When on, this 
option will cause the Address Book files on the Pen to be deleted after they are sent to 
the PC, when performing QuickLink. 

Changing the Host Application Settings 
1. Make sure that the This Pen Name will QuickLink with host applications check box on 

the QuickLink Settings dialog is checked and click the Host Settings button. Note: if the 
Host Settings button is inactive, see Activating Host Settings on page 59 for 
information on activating it.  

2. The Host Settings dialog appears. 
3. Select the Address Book row from the table. 
4. Click on the application name field (under the Host Application column). 
5. Choose the desired setting from the list that opens: 

o Outlook– the addresses from the mainadd file are converted to the Outlook 
Contacts format and placed in the MS Outlook Contacts folder, as specified in the 
Host Folder column. 

o None – select this option to cancel any host interaction with the Address Book 
application. 

6. Click OK to save changes and close the Host Settings dialog. Click Cancel to disregard 
any settings you have just changed. 

QuickLink Settings for the Internet Links application 
Changing the Mode or Flush Settings 
1. Access the QuickLink Settings dialog. 
2. Select the Internet Links row from the table. 
3. Click on the Change button. 
4. The Change QuickLink Settings dialog appears. 
5. From the QuickLink Mode section, click on the desired mode to activate its radio button: 

o Synchronize Pen and PC (the default) - all links from the main Internet Links file 
(mainlnk), those stored in the Pen and those created or modified in the PC 
(Desktop and Host Application) - are synchronized - resulting in one Internet Links 
file (mainlnk), identical on the Pen, on the Desktop, and in the Host application (if 
one is set). 

o PC to Pen will result in the internet links files, existing in the Internet Links 
application of the Desktop, being copied to the Pen (overwriting the ones on the 
Pen). 

o Don’t QuickLink the files of this application – when selecting this option, the 
QuickLink does not include the Internet Links application, or its files, and no 
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changes are performed - not on the Pen, nor in the PC (Desktop or Host 
Applications). 

6. In the right side of the Change QuickLink Settings dialog, click on the Flush check box 
to set the Flush mode. Checked is on, not checked is off (the default). When on, this 
option will cause the Internet Links files on the Pen to be deleted after they are sent to 
the PC, when performing QuickLink. 

Changing the Host Application Settings 
1. Make sure that the This Pen Name will QuickLink with host applications check box on 

the QuickLink Settings dialog is checked and click the Host Settings button. Note: if the 
Host Settings button is inactive, see Activating Host Settings on page 59 for 
information on activating it.  

2. The Host Settings dialog appears. 
3. Select the Internet Links row from the table. 
4. Click on the application name field (under the Host Application column). 
5. Choose the desired setting from the list that opens: 

o Internet Explorer – the links from the mainlnk file are placed in the Favorites 
folder of MS Internet Explorer, under a sub folder, as specified in the Host Folder 
column. 

o Netscape – the links from the mainlnk file are converted into Netscape 
Bookmarks, under a sub folder, as specified in the Host Folder column. Note: If 
you select Netscape and Netscape has more than one user profile, you are 
prompted to select the Netscape user profile under which you would like your links 
to be saved as bookmarks. Netscape must be updated to its latest version in 
order to be compatible with the Pen. 

o None – select this option to cancel any host interaction with the Internet Links 
application. 

6. Click OK to save changes and close the Host Settings dialog. Click Cancel to disregard 
any settings you have just changed. 

QuickLink Settings for the Tables application 
Changing the Mode or Flush Settings 
1. Access the QuickLink Settings dialog. 
2. Select the Tables row from the table. 
3. Click on the Change button. 
4. The Change QuickLink Settings dialog appears. 
5. From the QuickLink Mode section, click on the desired mode to activate its radio button: 

o Pen to PC (the default) will result in the stored table files from your Pen, being 
copied from the Pen to the PC. 

o Don’t QuickLink the files of this application – when selecting this option, the 
QuickLink does not include the Tables application, or its files, and no changes are 
performed - not on the Pen, nor in the PC (Desktop or Host Applications). 

6. In the right side of the Change QuickLink Settings dialog, click on the Flush check box 
to set the Flush mode. Checked is on (the default), not checked is off. When on, this 
option will cause the Tables files on the Pen to be deleted after they are sent to the PC, 
when performing QuickLink. 

Changing the Host Application Settings 
1. Make sure that the This Pen Name will QuickLink with host applications check box on 

the QuickLink Settings dialog is checked and click the Host Settings button. Note: if the 
Host Settings button is inactive, see Activating Host Settings on page 59 for 
information on activating it.  

2. The Host Settings dialog appears. 
3. Select the Tables row from the table. 
4. Click on the application name field (under the Host Application column). 
5. Choose the desired setting from the list that opens: 

o Excel – the stored pen files of this application are converted to .xls format and 
placed in the folder specified in the Host Folder column. You can access this 
folder using MS Explorer and double-click any of the files. The files will open in 
MS Excel. 

o None – select this option to cancel any host interaction with the Tables application 
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6. Click OK to save the changes and close the Host Settings dialog. Click Cancel to 
disregard any settings you have just changed 

QuickLink Settings for the Image Capture application 
Important: This is an add-on application that is not included in your default product. To use it, 
you must first add it to your Pen and Desktop application, using the CD-ROM (see Adding the 
Image Capture on page 76). 
The QuickLink operation is performed according to the settings set in the QuickLink 
Settings dialog (and its child dialog Host Settings).  
Changing the Mode or Flush Settings 
1. Access the QuickLink Settings dialog. 
2. Select Image Capture row from the table. 
3. Click the Change button. 
4. The Change QuickLink Settings dialog appears. 
5. From the QuickLink Mode section, click on the desired mode to activate its radio button: 

o Pen to PC (the default) will set that the stored image files from your Pen will be 
copied from the Pen to the Desktop. 

o Don’t QuickLink the files of this application – when selecting this option, the 
QuickLink does not include the Image Capture application, or its files, and no 
changes are performed - not on the Pen nor in the Desktop. 

6. In the right side of the Change QuickLink Settings dialog, click on the Flush check box 
to set the Flush mode. Checked is on (the default), not checked is off. When on – this 
option will cause the Image Capture files on the Pen to be deleted after they are sent to 
the Desktop when performing QuickLink. 

Changing the Host Application Settings 
There are no host applications for this application. The .bmp files from the Pen are transferred 
and displayed in the Desktop. Click the file name once to display it in the Desktop window, 
double-click the file name to open it in the graphic editor or viewer you have associated with 
.bmp files on your PC. 
Confirming Pen-PC Communications 
1. Connect the Pen to the PC. Make sure the connection is done in the same manner as you 

had chosen during the Set Up Product on PC procedure of the SuperPen CD-ROM. For 
example, make sure that the USB plug side of the USB cable is connected to the USB 
outlet on your PC (the same one you used when running the Set Up Product on PC 
procedure), and that the other side of the cable is connected to the PC-Link Connector 
outlet of your Pen. 

2. In the Desktop application, make sure that the Pen Communications are ON (this is the 
default). 
How to know if Pen Communications are on 

To find this out, simply confirm that the Pen Communications icon in the Desktop is 

pressed ( ), or that the first option in the Pen Communications menu in 
the Desktop bar, is Turn Pen Communications off. If the option says Turn Pen 
Communications On – select this option to turn the Pen Communications on. 
o When Pen Communications are off, or when the Pen is not connected properly, or 

when the necessary software is not working - the Desktop cannot detect 
communications from the Pen. 

o When Pen communications are on, the communications port is busy (you can see 
which one, in the Communications Settings dialog of the Desktop). You cannot 
use this port for any other purpose. 

3. If you fail to set the Pen Communications on, rerun the Set Up Product on PC procedure 
from the CD-ROM. This may fix the problem. If not, feel free to contact our Support Team 
(see Contact and Support Information on page 7).  

 

Performing a QuickLink 
1. Turn the Pen on.  
2. Long-press  until you reach the Pen Main Menu. 

3. Press  until QuickLink appears on the screen. 
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4. Press . The sending begins – the Pen displays “Sending…” and the PC shows a box 
with flying papers. If the process does not begin or the Pen reports “Sending… 
Connection failed” then please refer to Confirming Pen-PC Communications on page 63.   

5. When the process is done, OK the pop up in the QuickLink Desktop. 
6. The data of the applications appears in the Pen, Desktop, and Host applications – all 

according to the settings you have set in the QuickLink Settings dialog (see Setting the 
QuickLink Settings in the Desktop on page 57). 

 

Viewing and Editing Stored Files on PC 
1. Start the Desktop application (See Starting the Desktop Application on pages 57-57). 
2. Confirm that the desired Pen Name is the current one - so that its files are displayed in the 

Desktop. The current Pen Name is displayed in the desktop icon bar, for example: 

 
Note: The Pen Name is a profile used in the Desktop for storing the data of one scanning 
device. So, if you own one scanning device - it is highly advised to work with only one Pen 
Name – the default Pen Name “MyPen”. 

3. Click on the icon of the desired application, from the left pane of the Desktop. 
o When selecting the Notes, Tables or Image Capture applications (Note: Image 

Capture is an add-on application), the Desktop window displays 2 additional 
panes: 

1. The middle pane displays the list of all the files of this application. 
2. The right pane displays the entries from one file – the one selected from 

the middle pane. 
o When selecting the Address Book or Internet Links, the Desktop window 

displays 1 additional pane: 
1. The right pane displays the entries from one file. The name of the open 

file appears in the caption of the Desktop. You can open a different file, 
using the File\Open option, though it is advised in these applications to 
use the main* file, which by default is the one displayed. 

4. The data displayed for each application is the data that has been sent from the Pen (using 
QuickLink) or data that has been created in the Desktop. See Setting the QuickLink 
Settings in the Desktop on page 57 for more information on what happens to the Pen and 
PC data when performing QuickLink. 

5. Within each application you can create and edit files and entries, using the various options 
in the Desktop File menu or using the specific application options which are available 
when right-clicking the mouse on a selected file (from the file list in the middle pane) or on 
a selected entry (from the right pane). 

 
 

The Scan to PC function 
The Scan to PC function enables scanning printed text directly into a Windows application on 
your computer. The Pen enters the scanned text where the cursor appears in the active 
application on your computer.  
 

Preparing the PC 
Important: 
Transfer of stored file info between the Pen and PC requires Pen-PC Communications. 
Therefore, you must have already run the one time procedure Set Up Product on PC from 
the SuperPen CD-ROM. If you have not yet done this, please refer to Set Up Product on PC 
on page 9, and follow the instructions there. 
Starting the Desktop Application 
See Starting the Desktop Application on pages 57-57, and then return to here and proceed. 
Setting the Scan to PC Settings in the Desktop 
The Scan to PC Settings in the Desktop are already preset to the default, which will insert a 
space after each scan. If this default setting suits your needs – you need not perform any of 
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the procedures in this section, and you can continue to the next section Confirming Pen-PC 
Communications on page 65. 
Accessing the Scan to PC Settings Dialog 
In the Desktop application select Pen Communications from the menu bar, and then select 
the Scan to PC Settings… option. The Scan to PC Settings dialog opens, displaying the 
current setting. 

 
Using the Scan to PC Settings Dialog 
The Scan to PC Settings dialog displays what will be inserted after each scanned line that is 
scanned and sent to the open application. 
 
From the Scan to PC Settings dialog, select the desired option, then click OK to close the 
dialog and save any changes. The available options are:  

Space - inserts a space after each scan.  
Tab - inserts a tab after each scan. (This is useful, for example, when you are 
scanning into an Excel table. When you finish scanning, the cursor automatically 
jumps to the next cell.) 
Enter - The cursor moves to the next line after each scan (opens a new paragraph). 
Nothing - Nothing is inserted after each scan. The next scan continues immediately 
after the last character of the previous scan. 
 

Confirming Pen-PC Communications 
Refer to the Confirming Pen-PC Communications on pages 63-63, and then return to here and 
proceed 
Opening the Application 
Open the target application on your PC and make sure its window is the active window on your 
computer (click the window with your mouse) and make sure the cursor is blinking (if not, you 
may need to open a file for editing, depending on the application). 
 

Scanning Text to the PC 
1. Turn the Pen on.  
2. Long-press  until you reach the Pen Main Menu. 

3. Press  until Scan to PC appears on the screen. 

4. Press . The Scan text to the PC window appears. You are now ready to scan. 
5. Scan printed English text. To scan other types of text (numeric, inverse, or non-English): 

a. If you are scanning numeric (all digits) and/or inverse text (light text on dark 
background), please set the Pen as following: 

i. From the Scan text to the PC window, press  to open the Scan 
to PC Settings menu. 

ii. Select Scanning Options. 
iii. Press , , or  to toggle an option on or off. A checkmark (�) 

is displayed when the option is on. 
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iv. Press  to close the Scanning Options, save your settings and 
return to Scan text to the PC window. 

v. These settings remain as is - until you change them. 
vi. Scan. Make sure you are scanning the appropriate type of printed text 

(numeric and/or inverse) – according to what you set, or else the 
scanning results will be incorrect. 

b. If you wish to scan non-English text, change the scanning language of the 
Pen (see Scanning Language on page 66). 

6. The Pen displays “Sending…” and the text you scanned should appear, at the cursor 
point, in the PC application you have prepared (see Opening the Application on page 65). 
If this does not happen, or the Pen displays the error message “Error sending data to PC” 
- please refer to Confirming Pen-PC Communications on page 65. 

7. Continue scanning. Each new scan will appear at the cursor point plus a space, tab, new 
line – or nothing – according to what you have set in the Scan To PC Settings dialog in 
the Desktop (see Setting the Scan to PC Settings in the Desktop on page 64). The text 
you scan is entered into the application on the computer just as if it were being typed in 
with a keyboard. Highlighted text is overwritten. Text is inserted in Insert mode or 
overwritten in Overwrite mode. 

Note: Scan to PC does not interfere with your regular use of the application on your computer. 
You can input text with your keyboard and use all of the other features of the application while 
Scan to PC is active. 
 
 

The Preferences Menu 
Through the Preferences menu you can access setting screens, from which you can change 
the behavior of various Pen features. These features are already set to a default, which 
represents the most common settings. To change any of the settings, follow the instructions in 
this chapter. 
 

Accessing the Preferences Menu 
1. Long-press  until you reach the Pen Main Menu. 

2. Press  until Preferences appears on the screen. 

3. Press  to enter the Preferences menu. 
Following are descriptions of all the available settings in the Preferences menu, what they do 
and how to set them. 
Important: 
When exiting any of the following setting screens, the  button will activate what you just 
set, whereas  will close the screen without performing any change. 
 

 Scanning 
Language 

The scanning language should be set to the same language as the printed text you are 
scanning. 
To enhance the recognition of scanned text, you can also add a supporting speller (see 
Adding Spellers on page 71). 
Notes: 

o The default Scanning Language is English. 
o The current Scanning Language – and its speller (when available) are utilized only 

for texts scanned in the QuickLink applications. Within the Quicktionary application 
– the current dictionary sets its source language as the language to scan in and the 
recognition is based upon the available words in the dictionary. 

1. In the Preferences menu, scroll using  and  until the option Scanning Language 
appears on the screen and press . 

2. Scroll to the language you prefer by using  or . 
3. Press . 
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 Interface 

Language 
The interface language is the language in which the menus and messages appear. 
1. In the Preferences menu, scroll using  and  until the option Interface Language 

appears on the screen and press . 
2. Scroll to the language you prefer by using  or . 
3. Press . 
 

 Voice Settings 
 

The Voice Settings menu contains options for controlling the way words are read aloud by 
the Pen, in the Quicktionary application (see Hearing the Pen Read Words Aloud on page 
29). 
The Pen reads words out loud through its built-in speaker, or through the earphones included 
in the package. You can adjust the volume, pitch and speed of the reading voice to suit your 
specific needs. (Important: please lower the volume control before using the earphones to 
prevent ear irritation). 
 
Accessing the Voice Settings menu: 
From the Settings menu, scroll until the option Voice Settings appears on the screen and 
press .  
The following options are available in the Voice Settings sub menu: 

 Volume 
Use this option to adjust the volume level of the speaker. 
1. In the Voice Settings menu, scroll using  and  until the option Volume 

appears on the screen and press . 
2. The adjustment bar appears; adjust the volume level to the setting you want, 

using  or . 
3. Press . 

 Pitch 
 

Use this option to adjust the pitch of the speaker. 
1. In the Voice Settings menu, scroll using  and  until the option Pitch 

appears on the screen and press . 
2. Scroll to the pitch you want by using  or . The higher the number, the higher 

the pitch. 
3. Press . 

 Reading Speed  
This option enables you to adjust the speed at which the words are spoken out loud 
by the Pen. 
1. In the Voice Settings menu, scroll using  and  until the option Reading 

Speed appears on the screen and press . 
2. Scroll to the speed you want by using  or . The higher the number, the 

faster the speed. 
3. Press . 

 
 Communications 

Settings 
The Communications Settings contain the settings which are used for the Pen-PC 
Communications. The type of communications used are either Serial communications – in 
which case the USB cable provided in your package is used, or by Infra-Red communications 
– if you use an Infra-Red device. 
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Important: 
It is not advised to change these settings on your own. Only change them if so instructed by 
one of the Wizards provided in your CD-ROM or in the Desktop application.  
To set up Pen-PC communications please do one of the following: 
�� To set up serial Pen-PC Communications - using the USB cable provided in your 

package: 
Please perform the procedures provided in the “Set Up Product on PC” option 
of your CD-ROM. 

�� To set up Infra-Red Pen-PC Communications: 
Please run setup.exe from the CD-ROM folder Advanced Tools\Infra-Red 
Pen-PC Communications. 

Nonetheless, following is a description of the Communications Settings menu, though, as 
expressed above, it is not advised to attempt setting these options on your own. 
 
Accessing the Communications Settings menu: 
From the Preferences menu scroll until the option Communications Settings appears on 
the screen and press .  
The following options are available in the Communications Settings sub menu: 

 

 Connection 
Device 

Use this option to set the communications device you plan to use. 
o Cable is the default and should be set when communicating via the USB cable 

provided in your package. 
o Infra-Red device should be chosen if you have an internal Infra-Red (IR) device 

or if you use a ‘Serial (or USB) to Infra-Red’ cable. The supported Infra-Red 
drivers are: ACT-IR220L, ADAPTEC, CRYSTAL, ESI, PARALLAX.  

1. In the Communications Settings menu, scroll using  and  until the option 
Connection Device appears on the screen and press . 

2. Select the device you use, using  or . 
3. Press . 
Note: The setting here should match the setting specified in the Communications 
Settings dialog in the QuickLink Desktop application. 

 Baud Rate 
 

Use this option to adjust the speed at which the Pen-PC communications are 
performed. The default baud rate setting is 115,200. 
1. In the Communications Settings menu, scroll using  and  until the option 

Baud Rate appears on the screen and press . 
2. Scroll to the baud rate you want by using  or . 
3. Press . 
Notes: 
o The setting here should match the setting specified in the Communications 

Settings dialog in the Desktop application. 
o It is recommended that the baud rate should also be the same in the computer 

settings. Usually these settings can be found under Start/Control 
Panel/System/Device Manager/Communications Port/Port Settings. Change the 
‘Flow Control’ to ‘Hardware’ as well. 

o  
 Auto Shut-Off 

Time  
The Pen automatically shuts off after 2 minutes, if you do not scan or press any key. Use this 
option to change the automatic shut-off time. 
1. In the Preferences menu, scroll using  and  until the option Auto Shut-Off Time 

appears on the screen and press . 
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2. Change the automatic shut-off time, using  or . 
Note: The OFF setting will avoid the Pen from automatically shutting off. Please use the 
OFF setting with care - if the Pen is forgotten on the batteries may run out. 

3. Press . 
 

 Right/Left 
Handed  

Use this option to switch between right- and left-handed modes. Switching between these 
modes rotates the text on the display by 180º. The default is set to right-handed scanning. To 
change the setting: 
1. In the Preferences menu, scroll using  and  until the option Right-/Left-Handed 

appears on the screen and press . 
2. Scroll to the mode you prefer by using  or . 
3. Press . 
 

 Menu Type 
Use this option to switch between display style for your Pen’s menus: text only, icons only, or 
both text and icons. The default is both text and icons. To change the setting: 
1. In the Preferences menu, scroll using  and  until the option Menu Type appears on 

the screen and press . 
2. Scroll to the mode you prefer by using  or . 
3. Press . 
 

 Long-Press 
Interval  

Use this option to change the length of time you must keep a push button pressed for a long-
press (see Long-Press on page 12). To change the setting: 
1. In the Preferences menu, scroll using  and  until the option Long-Press Interval 

appears on the screen and press . 
2. Move the slider to the setting you want using  and . 
3. Test the setting by pressing and briefly holding down the  button. If the display flashes, 

the setting is fine. If the display does not flash, either adjust the setting to a shorter press, 
or press longer. 

4. Press . 
 

 Double-Click 
Interval  

Use this option to change the maximum length of time between two clicks for a double-click 
(see Double-Click on page 12). To change the setting: 
1. In the Preferences menu, scroll using  and  until the option Double-Click Interval 

appears on the screen and press . 
2. Move the slider to the setting you want using  and . 
3. Test the setting by double-clicking . If the display flashes, the setting is fine. If the 

display does not flash, either adjust the setting to a slower speed, or double-click faster. 
4. Press . 
 

 Contrast 
Use this option to adjust the brightness of the display. 
1. In the Preferences menu, scroll using  and  until the option Contrast appears on 

the screen and press . 
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2. The adjustment bar appears; adjust the contrast, using  or . The higher the number, 
the darker the display. Press . 

 

The Information Menu 
The Information menu has a number of options that display information about your Pen. 
 

Accessing the Information Menu 
1. Long-press  until you reach the Pen Main Menu. 

2. Press  until Information appears on the screen. 

3. Press  to enter the Information menu. 
Following are descriptions of all the available options in the Information menu. 
 

 Memory Status 
In the Information menu, select this option to view the amount of flash memory available on 
your Pen. Press  to view the amount of compactable memory space (see Compact 
Memory below). 
 

  Compact Memory 
In the Information menu, select this option to compact the space the Pen components use on 
the Pen’s flash memory card, thus maximizing the amount of free space.  
Important: 
Do not attempt to cancel the compact procedure (do not press ) or else the flash card will 
be damaged! Please wait until the process completes on its own. 
Please see Optimize Pen File System on page 81 for information on the Desktop option that 
compacts the space that the data and image files use on the Pen’s flash memory card. 
 

 Battery Status 
In the Information menu, select this option to check how much power is left in the batteries. A 
diagram displays the power level. 
 

 Serial Number 
In the Information menu, select this option to view the serial number of the Pen.  
 

 About 
In the Information menu, select this option to view information about the Pen software. 
 

General Tools and Options 
 

Beaming Stored Data Files to a PDA 
Beaming allows sending stored data, using Infra-Red communications, to an IrOBEX-
compliant device like a PDA or a smart phone and receiving data from such a device and then 
saving that data on your Pen. 
Note: The Communications Settings are not used when Beaming. 
 
o Please refer to Beaming on page 35 for instructions on using the Beaming feature in the 

Notes application. 
o Please refer to Beaming on page 43 for instructions on using the Beaming feature in the 

Address Book application. 
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The Pen Scanning Language 
The list of scanning languages on the Pen contains a list of languages that you can scan. The 
Pen recognizes the character sets of these languages. You can add a speller for a specific 
scanning language – to drastically enhance the quality of the recognition. The default Pen is 
already equipped for optimally scanning printed English texts. 
 
The Scanning Language setting should match the language of the printed text you are 
scanning – to direct the Pen as to which character set (and language speller, if available) 
should be used. 
 
Note: the Scanning Language does not affect scanning in the Quicktionary application – in 
which the language of the printed text you scan is determined according to the source 
language of the current dictionary. 

Adding Spellers 
If you plan to scan printed text in a language other than English (which is already installed on 
your Pen) – it is advised to add a speller for that language to the Pen.  
 
The SuperPen CD-ROM contains the following spellers which you can add to your Pen: 
French, Spanish, Swedish, German, Italian and Portuguese. 
 
To add a Speller to your Pen: 
1. Insert the SuperPen CD-ROM into the CD-ROM drive of your computer. 
2. The Main Menu appears. 

Note: If the Main Menu does not appear automatically, please do the following:  
a. Click the Windows Start button and select Run. 
b. Type x: \setup.exe (where ‘x’ is your CD-ROM drive letter), then click OK. 

3. Click on the Install Add-Ons button. The Install Add-Ons menu appears 
4. Click on the Spellers (for Pen) and follow the online instructions. 
 
After adding a speller - select the scanning language you wish to use (see Changing the 
Scanning Language ahead). 
 
Once you select a scanning language - the speller is automatically used by the Pen for 
recognizing the scanned text. If you select a language that does not have a speller, the Pen 
will notify you of this, so that you will be aware that the quality of the recognition will not be 
optimal (as it is when a parallel speller in installed on the Pen). 
Note: This does not affect the Quicktionary application in which the language of the text to 
scan is determined according to the source language of the current dictionary and the 
recognition is based upon the available words in the dictionary. 

Changing the Scanning Language 
If you scan printed texts in languages other than English, you should change the Scanning 
Language setting to the language you wish to scan in. 
The Scanning Language can be set in the general Scanning Language option or in the 
Select Language option in the Edit Menu of the current file you are editing, within one of the 
Pen applications. Following are instructions for these settings. 
 

The General Pen Scanning Language 
The Scanning Language option in the Pen Main Menu affects scanning and editing in all text 
scanning applications. When changing this settings, it does not affect existing texts already 
stored on the Pen – it just affects any new texts that you are to scan from this point on. 
 
This option is general – and is overridden by the language settings within each application (if 
those are set differently). For more information on the language settings within the 
applications, see the following section The Application Scanning Language on page 72. 
Setting it 
To change the general Pen Scanning Language, see Scanning Language on page 66. 
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The Application Scanning Language 
The Pen applications contain an option for manipulating the scanning language within the 
currently edited field or file. The scanning language setting affects the next scan or all next 
scans into the specific application and do not modify previously stored text. 
 
Note: This option does not exist in the Quicktionary application in which the language of the 
text to scan is determined according to the source language of the current dictionary and the 
recognition is based upon the available words in the dictionary. 
 
Setting it 
Following are references to the sections with information regarding the options for changing 
the scanning language within each QuickLink application: 
�� Notes – see Select Language on page 36. 
�� Address Book – see Next Address Lang. on page 41 
�� Internet Links – see Next Link Language on page 49. 
�� Tables – see Select Language on page 55. 
�� Scan to PC – see list item �5-�b in Scanning Text to the PC on page 65. 
 

The File Name Edit Menu 
This menu has options that affect the editing of file names when creating new files in the 
various Pen applications. 
Note: this menu is different than the Edit Menus appearing within the Pen applications, 
containing various options for editing of the actual application files (and not just file names). 
Resume Editing 
Select this option to close the Edit Menu and return to the file name. 
Activate Overwrite Mode/Activate Insert Mode 
This toggle option is a general option relating to the usage of the Character Bar. For 
information on this option, see Insert Mode and Overwrite Mode on page 73 in ‘The Character 
Bar’ section of this manual. 
Clear Text 
Will clear the file name. 
Scanning Options 
Allows setting the scanning of the file name to Numeric or Inverse. Use this only if you are 
scanning a file name that is numeric or inverse. Press , , or  to toggle the option on 
or off. A checkmark (�) is displayed when the option is on. Press  to close the Scanning 
Options and save your settings  - the current file name only. 
 

The Pen Interface Language 
The Pen Interface Language is the language in which all the menus, options and messages of 
the Pen appear.  
The default Pen contains the English interface language only. 
 

Adding Interface Languages 
If you wish to change the Interface Language of your Pen, you first need to add that interface 
language from the SuperPen CD-ROM. 
To add an Interface Language to your Pen: 
1. Insert the SuperPen CD-ROM into the CD-ROM drive of your computer. 
2. The Main Menu appears. 

Note: If the Main Menu does not appear automatically, please do the following:  
a. Click the Windows Start button and select Run. 
b. Type x: \setup.exe (where ‘x’ is your CD-ROM drive letter), then click OK. 

3. Click on the Install Add-Ons button. The Install Add-Ons menu appears 
4. Click on the Interface Languages (for Pen) and follow the online instructions. 
After adding an Interface Language to the Pen the Interface Language option appears in the 
Preferences menu of the Pen Main Menu. This option displays a list of all available Interface 
Languages on your Pen. 
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Changing the Interface Language 
To change the Pen Interface Language: 
1. Long-press  until you reach the Pen Main Menu. 

2. Press  until Preferences appears on the screen. 

3. Press  to enter the Preferences menu. 
4. In the Preferences menu, scroll using  and  until the option Interface Language 

appears on the screen and press . 
5. Scroll to the language you prefer by using  or . 
6. Press . 
The language you selected is activated, and all Pen menus and messages appear in that 
language. 
 

The Character Bar 
The Character Bar enables you to enter text manually by overwriting or inserting characters. 
The Character Bar is available when you are in Edit mode - while editing texts that appear in 
the various fields of the applications (see Accessing the Character Bar on page 74). 
  

 
The Character Bar 

 

Insert Mode and Overwrite Mode 
The Character Bar operates in either insert mode or overwrite mode, depending on the setting 
of the Activate Overwrite Mode/Activate Insert Mode toggle option in the Edit Menu of the 
current application.  
o When in insert mode (which is the default mode), the toggle option shows Activate 

Overwrite Mode and each character you select is added at the cursor.  
o When in overwrite mode, the toggle option shows Activate Insert Mode and each 

character you select replaces the highlighted character. 
 

Symbols, Modes and Sequences 
The Character Bar contains a basic character set (in lower case) for the selected language, as 
well as the following symbols, modes and sequences:  

 Alphabet  
The Latin alphabet sequence is the default sequence and its symbol is not displayed- unless 
the sequence has been changed. For example, if you select Numerals or Punctuation as the 
active sequence – the Alphabet symbol s displayed - to allow reselecting the alphabet as the 
active sequence (just scroll to the Alphabet symbol and press ). 
Also, if you had switched the scanning language of your Pen to a language that uses non-Latin 
characters (e.g., Hebrew), the Character Bar displays the Alphabet symbol - for returning to 
the Latin character set. 
 

 Punctuation 
If you scroll to the Punctuation symbol and press , punctuation becomes the active 
sequence and a series of punctuation marks is displayed. 

 Numerals  
If you scroll to the Numerals symbol and press , numerals become the active sequence 
and the numerals 0-9 are displayed. 

 Multiple Characters 
The Multiple Characters symbol indicates that you are in Multiple Characters mode (which is 
the default). In this mode, you can use the Character Bar to enter more than one character at 
the cursor. The Character Bar remains open until you press  to close it. To switch to 
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Single Character mode, scroll to the Multiple Characters symbol and press . The symbol is 
replaced with the Single Character symbol. 

 Single Character 
The Single Character symbol indicates that you are in Single Character mode. In this mode, 
after you enter a character, the Character Bar automatically closes and returns you to the text 
you were editing. To switch to Multiple Characters mode, scroll to the Single Character button 
and press . The symbol is replaced with the Multiple Characters symbol. 

 Delete 
Use the Delete symbol to delete characters. 
Note: If you are in Insert mode (see above) in a field (e.g., a file name) that has reached its 
maximum number of 200 characters, and you access the Character Bar, the cursor 
immediately jumps to the Delete symbol. It won't move from the Delete symbol until you delete 
a character from the field. 

 Space Character 
If you scroll to the Space character symbol and press , it enters a space in the text string 
(inserts the space – when in Insert mode, or overwrites the highlighted character with a space 
– when in Overwrite mode). 
 

Accessing the Character Bar 
To access the Character Bar: 
1. To access the character bar in each application, refer to the following sections of this 

manual: 
o In the Quicktionary application, see Manually Entering or Editing Text in the Input 

Screen on page 26. 
o In the Notes application, see Editing Notes Files on page 33. 
o In the Address Book application, see Editing Addresses on page 38. 
o In the Internet Links application, see Editing Links on page 46. 
o In the Tables application, see Editing Tables on page 52. 
o To access the character bar when editing a file name (in any QuickLink 

application), refer to The File Name Edit Menu on page 72. 
2. The Character Bar opens and the string of text you are editing is displayed above or below 

it. The first letter of the active character sequence is highlighted on the Character Bar, and 
appears in the string of text where it will be entered if you select it.  

3. Press  or  to scroll along the Character Bar. As you move from character to 
character, each character is highlighted and appears in the string of text. 

4. Press  to select the highlighted character. The character is entered into the text string 
(the character is inserted – when in Insert mode, or the character overwrites the 
highlighted character – when in Overwrite mode).  

5. If you are in Multiple Character mode ( ), you can add additional characters. To do so, 
repeat steps �3 and �4. When you are done, press  to close the Character Bar. If you 
are in Single Character mode ( ), the Character Bar automatically closes. 

 

Entering Character Variations 
To enter a variation of a character (e.g., in upper-case or with an accent):  
1. Make sure you are in Multiple Characters mode ( ), and scroll to the letter in the 

Character Bar. 
2. Press  or . The Character Bar is replaced by a list of variations for the selected 

letter. Pressing  initially places the cursor on the upper-case variation. Pressing  
initially places the cursor on the lower-case variation. 

 
3. Scroll to the variation you want using  or . 
4. Press . 
Note: To toggle out of the sequence for the selected letter without making a selection, press 

 or  again. 
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Entering One Character at a Time 
To enter one character at a time: 
1. Make sure you are in Single Character mode ( ).  

If not, scroll to the Multiple Characters button ( ) and press . The Character Bar 
toggles to single character mode. It remains in this mode until you reactivate the Multiple 
Characters mode (scroll to the Single Character button ( ) and press . 

2. Scroll to the required character in the Character Bar. 
3. Press . The new character is entered at the cursor location. 
 

Entering Multiple Characters 
To enter multiple characters: 
1. Make sure you are in Multiple Characters mode ( ), scroll to the first character you 

need and press . 
2. Repeat for each additional character you need. 
 

Deleting Characters 
To delete a character: 
1. Scroll to the Delete symbol ( ) and press . 
2. If you want to delete more than one character, make sure you are in Multiple Characters 

mode ( ) and press  for each character in the sequence that you want to delete. 
 

Changing the Character Sequence 
To select a different active character sequence from the Character Bar:  
1. Scroll to the required button (Punctuation , Numerals , or Alphabet ). 
2. Press . The selected character sequence becomes active. 
 
 

The Opticard 
The Opticard, located on the back of your Pen case, is a keyboard whose keys are bar codes 
you can scan. When you are in Opticard mode and scan a bar code key on the Opticard 
keyboard, your Pen enters the character it represents at the cursor of the display. 

 
You can use the Opticard to edit scanned text. The Opticard is also useful when words or 
phrases cannot be scanned because letters are too large, handwritten, or are on a type of 
background that the Pen is unable to scan. The Opticard enables you to enter these words or 
phrases manually by scanning in letters one at a time using the bar codes. 
 
To use the Opticard:  
1. When editing text - hold the Pen case horizontally, with the Opticard facing up and the 

Opticard title on the right. 
2. Scan the Opticard key in the bottom left corner of the Opticard, from left to right or from 

right to left, to activate Opticard mode. When Opticard mode is activated, the light in the 
tip of the Pen blinks more rapidly than before. 

3. Slowly scan the key of a letter, from right to left or from left to right, or touch the key gently 
with the tip of your Pen. The letter appears in the Pen display. 
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You can use the following keys or combinations of keys to enter the letters you want: 

Lower-Case Letters: To enter a lower-case letter, scan the key of the letter.  
Upper-Case Letters: To enter an upper-case character, scan the Shift key and then 
scan the letter key. 
CAPS LOCK: To activate/deactivate CAPS LOCK, scan Shift twice. Activating CAPS 
LOCK enables you to enter letters in upper case only. 
Ctrl Key: To enter a controlled character, scan the Ctrl key and then the letter key. 
Controlled characters can be entered only for the active character set. The Ctrl key 
can be used to enter characters specific to other languages, such as French or 
German. To enter a character specific to another language, such as an accent, scan 
the Ctrl key, scan the accent, and then scan the letter corresponding to the accent. 
Ctrl + Shift: To enter a controlled character in upper case, scan the Ctrl key, then 
scan the Shift key (or Shift, then Ctrl), and then scan the letter key. 
Space: To enter a space, scan the spc key. 
Delete: To delete the previous character, scan the Shift key and then scan the del 
key. 

4. Continue scanning in characters as required. 
5. When you are finished, scan the Opticard key again to return to normal scanning. 
 

The Image Capture Add-On 
The Image Capture allows scanning small images and storing them on the Pen. Once you 
have stored a file you can transfer it to your computer using the QuickLink option (from the 
Pen’s Main Menu). 
The Image Capture is not included in the default SuperPen product, but it can be added to the 
Pen. 
 

Adding the Image Capture 
To add the Image Capture add-on application to your Pen and Desktop: 
1. Insert the SuperPen CD-ROM into the CD-ROM drive of your computer. 
2. The Main Menu appears. 

Note: If the Main Menu does not appear automatically, please do the following:  
a. Click the Windows Start button and select Run. 
b. Type x: \setup.exe (where ‘x’ is your CD-ROM drive letter), then click OK. 

3. Click on the Install Add-Ons button. The Install Add-Ons menu appears 
4. Click on the Install Image Capture Application button from the Pen and Desktop Add-

On Applications section and follow the online instructions. 
After adding the application, it is added to the Desktop (to the list of icons appearing in the left 
pane) and to the Pen (listed in the Pen Main Menu). 
 
To use the Image Capture application: 
1. Activate the Image Capture and scan and store images. 
2. Use the QuickLink option from the Pen Main Menu to send all stored files to your PC 

(from all QuickLink applications). 
3. View the sent data in the Desktop or in any host applications you have set in the 

QuickLink Settings dialog of the Desktop (see Setting the QuickLink Settings in the 
Desktop on page 57). 

Following are detailed instructions for using the Image Capture application. 
 

Accessing Image Capture Application 
1. Long-press  until you reach the Pen Main Menu. 
2. Select the Image Capture option. 
3. The Image Capture application starts and its main menu appears. 
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The Image Capture Menu Options 
The Image Capture Main Menu 
The Main Menu contains the high level options of the Image Capture application. 
Accessing the Main Menu 
To access the main menu of the application, select Image Capture from the Pen Main Menu. 
When already in the Image Capture application press  to reach its main menu. 
Following is a description of the Main Menu options: 
Main Menu Caption – Current File 
The caption of the Image Capture Main Menu displays the current file. If no file is open – the 
caption displays “No Open File”. 
Edit Current File 
To edit the current file. 
1. Select Edit Current File. The ‘current’ file is the last file you worked on - whose name is 

displayed in the caption of the Image Capture Main Menu. 
2. The file is opened and its image is displayed (top left corner of the image). 
3. You can now scan in a new image. The new image will replace the old one. 
4. Press  to return to the main menu and save the changes. 
Scan New File 
To create a new image file: 
1. Select Scan New File. The Enter file name dialog box opens with an automatically 

generated name displayed in the file name field, in Scan mode (the text is highlighted).  
Note: If you want to edit the file name you can scan in a new name (which will 
overwrite the highlighted text) or edit the file name manually by pressing  once to 
enter Edit mode and then you can do any following: press  to display the 
Character Bar (see The Character Bar on page 73) or scan the Opticard key to 
activate the Opticard (see The Opticard on page 75. You may also press  to 
access the file name Edit Menu (this menu contains options specifically for editing file 
names, see The File Name Edit Menu on page 72). 

2. Press  to highlight the OK button and press  to open the new file. 
3. The Ready to scan Image: message appears on the screen. 
4. You can now scan in a new image. 
5. Press  to return to the main menu and save the new file. 
Open File 
To open an existing stored file: 
1. Select Open File. A list of existing files appears. 
2. Select the file you want to open. 
3. The file is opened and its image is displayed (top left corner of the image). 
4. You can now scan in a new image. The new image will replace the old one. 
5. Press  to return to the main menu. 
Delete File 
To delete an existing stored file: 
1. Select Delete File. 
2. Select the file you want to delete. 
3. Select YES when the confirmation message appears. 
Exit 
Exits the Image Capture application and returns to the Pen Main Menu. 
 

Scanning and Storing Images 
Creating, Editing and Opening Image Files 
1. From the Image Capture Main Menu, select any of the following options: 

o Select Edit Current File to open the current file. 
The ‘current’ file is the one whose name appears in the caption of this menu. 
If no file is currently open, the message No Open File appears in the caption. 
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In this case, selecting Edit Current File will first show the message No Open 
File and then show the Enter file name screen, suggesting a new file name. 

o Select Scan New File to create a new file and then open it. 
The Enter file name screen will first appear suggesting a default file name. 

o Select Open File to select an existing file and open it. 
A list will first appear suggesting all available files. 

2. The file opens and the previous image appears (when editing an existing file) or the 
Ready to scan an Image: message appears on the screen (when creating a new file). 

3. You now scan in a new image. 
Closing and Saving Image Files 
When done scanning an image, press  to close the image file and save your changes. The 
Image Capture Main Menu is displayed. 
Note: since image files are large, it is advised to perform a QuickLink function in order to send 
the images to the PC, and free space on the Pen. 
 

Exiting the Image Capture Application 
Long-press  until you reach the Pen Main Menu. 
 

Sending Images to PC (QuickLink) 
Important: 
Transfer of stored files between the Pen and PC requires Pen-PC Communications. 
Therefore, you must have already run the one time procedure Set Up Product on PC from 
the SuperPen CD-ROM. If you have not yet done this, please refer to Set Up Product on PC 
on page 9, and follow the instructions there. 
To send stored images to the PC: 
1. Turn your PC on. 
2. Make sure that your Pen and PC are connected. Note: they should be connected in the 

same manner as you had chosen during the Set Up Product on PC procedure of the 
SuperPen CD-ROM. For example, make sure that the USB plug side of the USB cable is 
connected to the USB outlet on your PC (the same one you used when running the Set 
Up Product on PC procedure), and that the other side of the cable is connected to the 
PC-Link Connector outlet of your Pen. 

3. Start the QuickLink Desktop application and make sure that Pen communications are on 
(see How to know if Pen Communications are on on page 63). 

4. Turn the Pen on. 
5. Long-press  until you reach the Pen Main Menu. 

6. Press  until QuickLink appears on the screen. 

7. Press . The sending begins. Note: When performing QuickLink - all stored files (from 
all QuickLink applications) on your Pen are sent to the PC, according to the QuickLink 
Settings set in the Desktop application (see Setting the QuickLink Settings in the 
Desktop on page 57). 

8. When the process is done, OK the pop up in the QuickLink Desktop application. 
9. Click the Image Capture icon in the QuickLink Desktop application. 
10. The list of image files you transferred from the Pen - appear on screen. 
Note: By default, the stored files of the Image Capture application are copied from the Pen to 
the Desktop application and then deleted from the Pen. See QuickLink Settings for the 
Image Capture application on page 63 for information on changing these settings. 
 
 

Additional Information 
 

Pen Care and Cleaning 
Your Pen conforms to the highest standards of craftsmanship and manufacture. To ensure its 
continued excellent performance, please adhere to the following instructions for care and 
cleaning: 
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�� Protect the Pen from direct sunlight, heat, dampness and dust. Do not drop or knock the 
device; keep it in its protective plastic case to avoid scratches. ALWAYS replace the tip’s 
protective cover when not in use. 

�� Clean the Pen only with a soft, dry cloth. Never use a wet cloth or solvents such as 
benzene or diluting agents. 

�� NEVER clean, wipe or tamper with the Pen’s tip. It contains a sensitive electronic eye 
that could become damaged. 

�� Should your Pen require servicing, contact the retail outlet where you purchased your 
unit. 

 

Pen Batteries 
The Pen uses two AAA batteries. To check the batteries, select View Battery Status from the 
Information menu in the Main Menu. 
If the batteries are low, the following picture of a battery with a slash through it appears on the 
Pen’s display: 

 
 
When the batteries are about to run out, the Pen shuts down automatically. 
When replacing batteries, use only high-quality, alkaline batteries. 
 

Pen Technical Data 
 
Processor  ARM 7 TDMI 
RAM memory 192KB 
ROM memory 8MB minimum 
Socket for flash memory 
cards 

2MB/4MB/8MB 

Communications Serial (USB Cable, IR) 
IrOBEX 

Optical head 128 pixels linear array 
image sensor 

 400 DPI resolution  
Display dimensions 61mm x 20mm/2.4” x .8”  
 122 x 32 pixel resolution 
Supply voltage Two 1.5v AAA batteries 
Weight  90 grams/3 oz. (not 

including batteries and/or 
flash memory card) 

Size Length (with cover): 163 
mm/6.4” 

 Width: 38 mm/1.5” 
 Height: 23 mm/1” 
�� Low power consumption 
�� Compliant to FCC class B 
�� Compliant to CE standards 
�� UL listed 

 

Extending the Pen’s Memory 
It may be possible to extend the Pen’s memory to allow adding additional Pen Components to 
your Pen. Extending the Pen’s memory is done with WizCom Technologies’ Memory 
Extension Kit (MEK) product. 
Important: 
Please contact our offices for more information on extending your product (see Contact and 
Support Information on page 7). 
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Advanced Desktop Features 
The Desktop main functionality is to enable the Pen-PC Communications, specifically 
supporting the QuickLink and Scan to PC functions. These functions are described in detail 
throughout this manual. 
 
In addition to the main Desktop functions, there are additional options that are available in the 
Desktop. Please refer to the Desktop Help file for full information of the Desktop options  
 
Following is a short description of some of these options, and what they can be used for. 
 

The Desktop Icon in the System Tray 
When the QuickLink Desktop is running, an icon ( ) appears in the system tray on the right 
side of the Windows taskbar at the bottom of the screen. If, during the QuickLink Desktop 
installation, you specified that the Desktop should launch on startup, the icon appears 
automatically each time you start your computer. Otherwise, it appears only when you start the 
Desktop application manually. 
 
This icon makes it easy to execute the most common Desktop commands. When you click on 
the icon, a pop-up menu appears. The menu is particularly useful if you are scanning directly 
into an application, because it allows you to execute commands without having the QuickLink 
Desktop window open. The pop-up menu has the following options: 

o Show/Hide Window - Displays or hides the QuickLink Desktop window. 
o Turn Pen Communications On/Off - Enables or disables communications between the 

Desktop and the Pen.  
o When Pen communications are on, the communications port is busy (you can see 

which one, in the Communications Settings dialog of the Desktop, see 
Communications Settings on page 81). You cannot use this port for any other 
purpose. 

o When Pen Communications are off the Desktop cannot detect communications 
from the Pen and the port is free for other purposes. 

o QuickLink Settings - Displays the QuickLink Settings dialog box so that you can view 
and modify the QuickLink Settings of the QuickLink function. 

o Scan to PC Settings - Displays the Scan to PC Settings dialog box so that you can 
select the character to be inserted after each line of text you scan. 

o Log - Displays the log of the QuickLink operations. 
o About - Displays the version number of the Desktop application. 
o Exit - Closes the Desktop application. 
 

Add\Remove Pen Components Dialog 
This dialog, available from the Pen Communications menu of the Desktop, can be launched 
only when the Pen is connected and in the PC-Controlled Communications mode. It shows 
Pen Components, which are the actual software files for the Pen. 
o The left window displays the Pen Components stored on the PC (only *.qlb files that 

reside in the “Pen Components” folder under the Desktop installation directory). 
o The right window displays the Pen Components that are on the connected Pen. 
This dialog is for advanced users only and you will probably never need to use it, unless for 
Support purposes – while guided by our Support Team. Its main purpose was to allow 
upgrading the Pen – but this functionality is currently covered (in a more user-friendly manner 
– in the various options of the SuperPen CD-ROM. Nonetheless, here are a few functions of 
this dialog, that may come in hand: 

Menu Order – press this button to view and change the current order of the options in 
the Pen Main Menu. 
Details – press this button to open a text file displaying the details of all Pen 
Components currently installed on the connected Pen. This is useful for support 
issues. 
Current flash memory status – this bar displays the status of the flash card in your 
Pen (this is the external card, which information and files can be added or deleted 
from). 
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Compact – press this button to compact the space the Pen components use on the 
Pen’s flash memory card, thus maximizing the amount of free space. This option is 
identical to the Pen option Compact Memory (see page 70) and it is advised to use 
the Pen option, since it does not involve Pen-PC Communications. 

 

Optimize Pen File System 
This function, available from the Pen Communications menu of the Desktop, can be 
performed only when the Pen is connected and in the PC-Controlled Communications 
mode. The function compacts the space that the data and image files use on the Pen’s flash 
memory card, and frees up areas that contain deleted application data. 
It is worthwhile optimizing your Pen’s file system from time to time. In addition, it is a good idea 
to do this when you have deleted a lot of data from your Pen. 
Important: Do NOT abort the Optimize Pen File System process before it is completed. 
Failure to complete the process may result in the loss of all data from your Pen. 
 

Log 
To view a log containing the history of the last three QuickLink sessions, select Log from the 
View menu. 
 

Communications Settings 
This dialog, available from the Pen Communications menu of the Desktop, displays the 
settings used for Pen-PC communications. When performing the 3 step Set Up Product on 
PC procedure from the CD-ROM, the correct settings are automatically written to this dialog. If 
when performing Pen-PC Communications (QuickLink, Scan to PC, etc.) – you use the exact 
same setup you used during the Set Up Product on PC procedure (for example, you use the 
same port for connecting the cable) – you should not have any problems, and this dialog can 
serve as information only. If you have problems with Pen-PC Communications, try rerunning 
the Set Up Product on PC procedure from the CD-ROM. If you cannot fix the problem, you 
may need to change settings in this dialog - either according to directions from our support 
team, or according to directions given in the Communications Wizard (see following item). 
 

Communications Wizard 
This dialog, available from the Help menu of the Desktop, runs a wizard which instructs you 
step by step on establishing the Pen-PC communications, and then confirms these 
communications and writes their settings into the Communications Settings of the Desktop. 
 
Your CD-Rom contains a 3 step Set Up Product on PC procedure which also establishes the 
Pen-PC Communications, in a more user friendly manner. Therefore, if you have problems 
with Pen-PC Communications - it is advised to rerun the Set Up Product on PC procedure 
from the CD-ROM. Only if you fail to solve the problem, you may want to try this Wizard. 
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Troubleshooting 
Here are some common problems you may run into, and how to try and fix them yourself. 
In all cases: if you cannot fix the problem, please contact our Support Team (see Contact and 
Support Information on page 7). 
 
Problem: 

I need to restore my Pen. Things are missing! 
Solution: 

At times, an upgrade procedure performed on your Pen may fail, or the flash card of 
your Pen may be damaged. The result may be that certain options have disappeared 
from your Pen. 
To fix the Pen: 
1. Replace the Pen batteries with fresh ones. 
2. Confirm that the flash card is properly inserted in its place. 
3. Turn the Pen on as follows: press  and keep pressing it while you press the 

power button . 
4. Run one of the Add-On procedures from the CD-ROM. Follow the instructions. 
All the add-on procedures have an initial stage in which the original Pen is 
restored. This should fix the problem. 
If you cannot fix the problem, please contact our Support Team (see Contact and 
Support Information on page 7) 

 
Problem: 

I need to reinstall the Desktop application. 
Solution: 

Please click on the “Set Up Product on PC” button from the main menu of the CD-
ROM, and then click on the second button “2. Install the Desktop Application”. 

 
Problem: 

I cannot get the Pen and PC to communicate! 
Solution: 

Please click on the “Set Up Product on PC” button from the main menu of the CD-
ROM, and perform the 3 step procedure. 

 
Problem: 

I had the Pen and PC Communicating, but now the port seems to be “locked”. 
Solution: 

Before starting, it is advised to remove the cable from the USB socket – and re-insert 
it. Then you can re-run the “Set Up Product on PC” procedure from the CD-ROM 
and\or run the Communications Wizard in the Desktop application. If all fails, try 
restarting your PC to free the port. 

 
Problem: 

How can I fix a calibration error?  
Solution: 

Replace the batteries with fresh ones. If this does not solve the problem, please 
contact our support team (see Contact and Support Information on page 7) 

 
Problem: 

My Pen will not turn on or it turns on improperly.  
Solutions: 

o Check to see whether the Pen is turned on, that it is in scanning mode and that 
the protective cover has been removed from the Pen tip. 

o Check whether you are scanning regular text in inverse text mode or inverse text 
in regular text  

o Replace the batteries with fresh ones. 
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o Turn the Pen on as follows: press  and keep pressing it while you press the 

power button . 
 
Problem: 

The Pen wheels are squeaky. How do I solve this?  
Solution: 

The wheels should not squeak and they really do not tend to. But if you find that your 
wheels squeak even for a moment, you can run the tip back and forth on paper with 
just a bit of pressure to eliminate the noise, or use the edge of a pencil-tip to cause a 
tiny amount of graphite to fall between the wheels and the tip which will lubricate the 
axle. The problem should be temporary but if not, the Pen can be exchanged. 

 
Problem: 

The text in the display appears upside down. 
Solution: 

Adjust the Right/Left Handed mode. 
 
Problem: 

The error message ‘Excessive lighting’ appears on the display. 
Solution: 

Move the Pen away from the strong light source (such as sun, lamp, etc.) shining 
directly on the tip.  

 
Problem: 

The error message ‘Scanned too fast’ appears on the display. 
Solution: 

Scan again - more slowly. 
 
Problem: 

When I insert the earphone plug into its outlet, the Pen shuts off. What should I do?  
Solution: 

This problem occurs when the plug is not inserted properly. If it is not inserted firmly, 
the connections are loose, which causes the Pen to switch itself off automatically. 
Push the earphone plug very firmly into its outlet, until you hear a “click” sound. 

 
Problem: 

Why can’t I hear the Pen read out loud? 
Solutions: 
o Check whether the volume is high enough – both on earphones and in the Set Volume 

option. 
o If you are using an earphone, check whether its plug is connected firmly to the outlet (you 

should hear a “click” sound which verifies that the earphone is indeed connected). 
o For more information, see Hearing the Pen Read Words Aloud on page 29. 
 
Problem: 

The error message ‘Word not found’ appears when trying to define a word. 
Solutions: 
o Verify that you are scanning printed English text. 
o Try scanning again. 
o It may be that the word you have scanned is not included in the dictionary, for example, 

proper names are not included. 
o For more information, see Scanning on page 12. 


